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1. OVERVIEW
The Expert software is the user interface for Tritex actuators, which includes the latest TTX series. It provides a simple way to 
select all aspects of configuration and control required to set up and operate any member of the Tritex actuator family. Pages 
provide access to view and change all parameters necessary to configure a motion application. Application folders provide a 
convenient way to store and organize applications and individual actuator parameter sets.

The Expert software allows for customizable views of the Tritex drive features for various industries and applications. For example, 
a valve application may use different motion features than a clamping application. The concept of different views is to simplify and 
customize the operation by only showing the parameters needed for the specific application and allow industry specific names for 
the drive parameters.

This edition of the Expert Software Instruction Manual applies to Tritex actuators, updated to include features in actuator firmware 
V4.00 and Expert software release 4.13.9.26. Features new to this version are identified as such. In order to make full use of the 
latest features, the latest Expert Software release must be installed. For the most part, features introduced in previous firmware 
versions no longer identify the version in which the feature was introduced.

This manual does not describe detailed operation and use of Tritex actuators with CANopen communications option. These 
actuators are substantially different in operation, but sections 1 through 5 still apply on connecting and using Expert software.

This latest Expert Software Instruction Manual deletes most references to legacy products Tritex I and EXP, though the software 
still supports these products. The previous version of this manual will still be available for these products as well.

For the porpose of brevity the T2M and TDM will be referred to as T2X and TDX respectively in this manual as they are electrically 
the same.  

TRITEX® SERIES
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2. INSTALLATION
2.1 GENERAL REQUIREMENTS
Operating system: Microsoft Windows 7 or Windows 10 operating system.

.NET framework 4.0 (included with installation package)

2.2 INSTALLATION PROCEDURE
The software is also available for download. Curtiss-Wright Actuation Group now has a combined website www.cw-actuationgroup.
com. The previous website www.exlar.com redirects here. The current revision software download itself is at https://www.cw-
actuationgroup.com/Resources/Exlar-Resources/Expert-Software. 

Before installation, note that any previous versions of Expert software are removed. Copy an older version to a different location 
before installing the new version. 

Follow the Windows prompts during installation. By default, it installs in C:\Program Files (x86), creating folders \Exlar\
Tritex, but can be installed in other locations, such as C:\Users\Public\Documents. 

Please report any problems you experience to Tech Support as we continue to improve the operation of the Expert 
Software. 

Commissioning Software Tool
TRITEX® SERIESactuators

https://www.cw-actuationgroup.com/About/Exlar-Automation
https://www.cw-actuationgroup.com/About/Exlar-Automation
http://www.exlar.com
https://www.cw-actuationgroup.com/Resources/Exlar-Resources/Expert-Software
https://www.cw-actuationgroup.com/Resources/Exlar-Resources/Expert-Software


6 | Expert™ Software Manual for Tritex® Actuators Curtiss-Wright | Rev M | PN47703 | 10/07/2022

3. WELCOME SCREEN
When the Expert software is opened for the first time, the below screen will be displayed. Subsequent opening of the 
software will start with the previously used application. The three main sections of the software include: (1) Toolbar 
section, (2) System Panel and (3) the main body. 

3.1 TOOLBAR
Not all of these are active until a connection to a drive is established.

Opens the New Application dialog box to create a new application and drive file.

Opens a navigation window to select a Drive File to open.

Saves the current parameter settings for the Application file and Drive file.

Opens the Network Manager dialog box.

Scans a network for an actuator with type matching the drive file and goes online 
to it.

Reads all parameter values from the actuator to the open drive file.

Writes most user parameter values from the drive file to the drive.

Display a list of the Application’s pages to select which ones are displayed.
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3.2 SYSTEM PANEL
The System panel will display the configuration tree for the various pages included 
in the application. Click on ‘+’ next to the Pages icon to expand the tree into several 
categories. Each category is a group of related pages that expands to show the 
included pages. Click on the name of the page to display it. The System Panel is a 
more organized and convenient way of moving from page to page than the View-
>Page menu item or Toolbar button, but all select page display.

The page list shown here is an example and may vary based on the application type 
and actuator type.

3.3 MAIN BODY
The main body is where pages appear. The default page layout displays the Status 
page docked at the bottom of the main body. If displaying the Input Function Control 
page or Output Function Status page, they will appear docked at the right side of 
the main body. The docked pages contain active status or controls often referenced when configuring and checking operation of 
an actuator. Most other pages appear in the remaining main body space one at a time as selected to configure some part of the 
application. How each page appears can be changed and saved as part of the application.  

4. THE “APPLICATION”
It is best to consider a Tritex application as a complete operating entity. At its core is an actuator to convert electrical energy 
into motion. Firmware running in the actuator controls the motion according to a set of operating parameters in different 
functional groups. Factory parameters, sometimes called system parameters, set under-the-hood characteristics unique to an 
actuator such as calibration values. Users rarely change factory parameters. A lock protects them from accidental change. User 
parameters configure motion type and characteristics, determine the response to command signals, define the information 
sent in output signals, and defines blocks of data transferred with advanced communications options. Display parameters 
convey status information to Expert software or other devices. Factory and User parameters are stored in non-volatile memory 
in the actuator, while display parameters are not. A PC running Expert software serves as the human-machine interface for 
configuration and set-up. A set of pages are also part of the application. Pages are used to organize and display operating 
parameters and provide the ability to change these parameters in the actuator. There are several application templates with 
pages that provide specialized views of parameters based on how the actuator will be used, such as for general motion control 
or valve positioning. There are additional or alternate pages that can be included to access advanced features not used in most 
cases. With different page sets, applications can offer different views of the same set of operating parameters.

Applications with CANopen communications run on different firmware and have radically different motion profiles and 
operating parameters. This manual supports actuators with CANopen communications but does not describe the 
differences in parameters, features, and motion. See the CANopen manuals when using Tritex II with CANopen.

Expert software saves a record of an application into an application folder containing an application file and two sub-folders named 
Drive Files and Page Files. An application file ends in .eapp. The Drive Files folder contains at least one drive file that ends in .edrv. 
The Page Files folder contains definitions of all pages used to display and manage the parameters in the drive file, page by page. 
Although all files are text based xml files and open with a text editor, do not allow any program except Expert software to make 
changes to these files.

It is best to have an application folder saved for every actuator and available where the actuator is located to aid in local or remote 
service and troubleshooting. The application file contains the current associated drive file, a list of associated page files, and a few 
parameters that control properties of page files based on drive type and options. 
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A drive file contains all the actuator parameter names, addresses, scaling, and most values. Parameter values are data 
downloaded to and uploaded from a drive and follow Modbus formatting rules. The drive file contains values for all user and 
factory configuration parameters and some display parameters for one actuator. Other display parameters are not saved in a drive 
file at all and can be viewed only when connected to the actuator. The Drive Files folder is a good place to store copies of previous 
user configurations during development. Machine builders can keep a drive file for each actuator of the same model doing the 
same job in application’s Drive Files folder. Otherwise, there should be one drive file for each application, so that an application is a 
complete record of a single actuator.

The Page Files directory contains a page file ending in .epag for each page in an application. The page file contains the information 
for viewing and controlling the windows screen as viewed in the Expert software. Page files may be different between applications 
even if they have the same name, or display parameters differently based on characteristics of the application such as drive type, 
actuator options, or firmware version. Let Expert software manage the files in this folder.

4.1 CREATE NEW APPLICATION
Unless an application folder is already available for the actuator, the user must create a new application. Refer to the actuator 
model designation to select Drive Series according to the following table: 

Select File → New → Application or click on the  button. 
1. Select the General Tab 

2. Select the Drive Series of the target actuator. This step must be done before Option or Template selections.

For most actuators, the drive series depends on frame 
size and input power AC or DC. See table above. 

DC 48 V Tritex I (TLM, RTM, RTG) and EXP 24 are 
legacy products with limited support.
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3. Select the Option Board installed in the target actuator as it appears in model designation. For –EIP or –EIN in 
model select EIP. For –TCP or –TCN in model use TCP. For -PIO or PIN use PIO. For –COP or –CON in model 
use COP.

4. Select the desired Application Template, usually Generic unless the application is a proportional valve positioner. 

5. Enter the Application Title. It shows up in the upper left corner of the main Expert window. 

6. Enter the Application Author and Description (optional).

7. Click on the Page Selection tab to see the list of pages already included in the application on the right. In most 
cases, all the pages needed will already be included. 

8. Select any additional page desired from the Available 
Pages. Sometimes an Advanced.. page is needed and 
the standard page can be highlighted and removed. 
The description of a highlighted page appears below 
the lists. With an available page highlighted, click the 
Add button on the right side. The page will appear at 
the bottom of the Included Pages list. The arrow buttons 
above the Add button move a selected page up or down 
in the list, affecting the order in which pages appear in 
lists.

9. Use the Find Page button to add pages from a directory 
other than the ones installed with Expert.

10. After pressing OK on the New Application window, a 
Save Application As… window pops up. The default folder for computer user kallin is shown, but in general uses 
the last save location. It always tries to add an extra folder level based on Drive Series. To save to a different 
location use the Browse… button or type or paste a path directly into the Folder area. Application Name starts 
out matching the Application Title, but may be changed, to differentiate versions for instance. It is the Application 
Name that determines the default folder name and application file name. The final name and location of the ap-
plication file is shown in the bottom area. It always creates a new folder that contains Drive Files and Page Files 
folders as explained in the Overview section above.
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The application file must be saved to view pages and connect to an actuator. Pressing the Cancel button in the Save Application As… 
window, returns to the New Application window.

At this point, there will be an application folder with one drive file in the “Drive Files” folder named for the Application Template, 
usually “Generic.edrv.” This drive file knows nothing about the parameter set in a real actuator. Immediately after connecting to an 
actuator, the parameters in the actuator must be uploaded from the actuator to Expert and then the application or drive file saved 
again. Using the File-> Save-> Drive File As… command allows giving the drive file a better name. This creates a drive file that 
matches the parameters in the actuator, including factory parameters, and puts it in the Drive Files folder in the current application. 
The parameters can then be edited and saved to actuator with a Download and to the computer with a File-> Save-> command.

4.2 OPEN EXISTING APPLICATION

Select File → Open → Application. This will provide a list of the last several applications used by Expert software. If not in the list, use the Browse 

Other Appl. button to navigate to the desired application. This is used to open an application and drive file already developed on one actuator for 

download to a different actuator. The user must always be aware of that parameters saved in a drive file may not match what is running in an actuator 

unless they are matched with an Upload or Download and the drive file saved to the computer again.
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5. COMMUNICATION SETUP
All Tritex actuators use an RS485 wired connection with a Modbus RTU protocol for communications with Expert software running 
on a PC. Therefore, an adapter will be required to interface from an RS232 or USB port on the PC to the RS485 port on the 
actuator. Our model CBL-USB485-M8-xxx cables provide USB port to the M8 connector provided on all standard Tritex II actuators 
(See Installation Manual for details on the RS485 port and alternative wiring). Expert software may connect through a Modbus TCP 
connection, but only if the Tritex actuator has the –TCP or –TCN option.

Multiple actuators may be multi-dropped on a single Modbus network, though this is generally only done with a permanently 
connected Modbus-RTU master. Multi-drop requires all devices to have matching parameters for BAUD rate, parity and stop bits 
and unique Drive ID’s. It is best to reserve Drive ID = 1 for network maintenance use when using a multi-drop network. 

In most cases a PC running Expert software will be connected temporarily to only one actuator at a time. In this case it is still 
convenient to have all devices with matching BAUD rate, parity and stop bits, but all actuators can be left at default Drive ID = 1. 
Refer to Changing Drive Parameters section for setting up actuators.

5.1 DEVICE DRIVER
If using a USB to RS485 (Modbus RTU) converter, the device driver must be installed on the PC. On most PC’s, the 
necessary driver is already available, and the device is plug-and-play. To verify the device driver has been installed 
and the device is recognized, go to the PC Control Panel/System/Hardware/Device Manager, and expand the Port 
Settings to a dialog box. See the image below on the left.

The name of the device driver installed must show under Ports. If it does not, the Expert software cannot connect to the PC 
COM port. COM4 is used in the example above. Use the correct COM port number in the Expert software when setting up PC 
communication. Double-click on the COM port to see the screen above on the right to verify the converter’s device driver is 
working.

5.2 ADD NETWORK
Select View → Network Communications Manager or click on the  button.

Click on the Add Network button. The window shown on 
the right pops up. Select ModbusRTU from the drop-
down and OK.
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  The MODBUS Network Properties window appears with each of the two tabs shown below. Field descriptions follow.

First scan ID / 
Last scan ID

1 Define the Modbus ID the software will start and stop scanning. Used for multiple actuators on 
one RS485 Modbus network. (Default 1 and 1.) In the example above, only ID “1” will be scanned.

Response 
Timeout

The Expert software will ‘time out’ if a response is not received from the actuator within this time. 
(Default 200ms) Only a highly unusual network with repeaters would take longer.

Retry Attempts
If a “time out” or other communications error occurs, the software will try again this many times 
before giving up and going “offline”. (Default 1) There is little practical reason to select any other 
value. This has nothing to do with actuator communications faults.

1

The default actuator Modbus ID is “1”. These settings will have to be changed to include all ID’s assigned to 
actuators on the Modbus network.

Communica-
tions Port 
Name

This is the serial communication port number. If the PC has an RS232 port, it is typically COM1 or 
COM2. If a USB converter is used, it is typically COM3-COM6 or higher. If multiple ports are shown 
in the drop-down menu, it is sometimes necessary to simply use trial and error to find the right one. 
Red (transmit) and green (receive) LEDs on the USB to RS485 converter cable can be useful to see 
activity.

Baud Rate

2 Selects the Modbus network BAUD (or bit) rate (default 19200). The default baud rate of Tritex 
actuators is also 19200. Unless 38400 speed is required for throughput when using a Modbus 
master for control, it is best to leave all devices at 19200.

Parity and 
Stop Bits

2 Selects the Modbus network Parity and Stop Bit settings (default Even parity with 1 stop bit). This is 
generally not changed unless required for some other master device.

Extra frame 
delay

Set to 0 ms unless more time is required by a RS485 communication converter or repeaters or some 
other device on a network. (Default 0 ms)

2 BAUD Rate and Parity and Stop Bits settings for master (Expert or controller) and all actuators on a network must be the 
same. The software does not attempt to make an ‘auto’ baud rate connection. If the actuator setting is unknown, different 
settings can be tried by changing the parameters. 
When making changes to all devices on a network, change the actuators first. Changes do not become effective until the 
actuators are restarted, usually with a power cycle. Then change the master settings.

The Expert software saves the COM port settings. If the same communication port is used, this step can be skipped in future 
sessions, and Expert can go online with an actuator by connecting as described in the next section. This is another reason is 
convenient to keep all actuators with the same communications settings except Drive ID on multidrop networks.
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Click on the Scan Network button.

When Expert finds a device or devices connected to the configured COM port, the connections will appear in the Connections 
section with Status = ONLINE. This does not mean it is Connected and actively communicating to the actuator; only that the 
connection is available. 

If no device is found, a line appears temporarily with Status = OFFLINE and Type = -1 and a pop-up window will say “Unable to ping 
connection” or “Unable to access port”. With the first message, make sure the actuator is powered up and the communications cable is 
connected. It is possible the port parameters do not match. With the second message verify that the port is not being used by a different 
program and that the Device Driver is working properly. Sometimes the port connection drops out and it may be necessary to click on 
Remove Network and start over with Add Network… Rarely the USB to RS485 converter gets hung up and it may be necessary to unplug 
the USB connector and plug it back in.

5.3 CONNECTING TO DRIVE
In order to make the connection and be actively online, an application and drive file must be open in Expert. Furthermore, the drive 
type in the drive file and the drive type of the actuator must match or an error pop-up will appear announcing “Wrong Drive Type”. 
Drive Type in the open drive file shows up in the Status Bar at the bottom right corner of the main Expert window while the next box 
indicates the connection status as shown below with drive type and Modbus ID appearing when connected.

Not connected:  Connected: 

The drive types of available actuators appear under Type in the Connections table of the Network Manager and appears as above 
when connected. Drive type is not the same as Drive Series when creating an application, but if the correct Drive Series and I/O 
option is selected, the drive Type will be correct. CANopen is not currently offered with Tritex TTX actuators.
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Drive Series Drive Type except CANopen Drive Type with CANopen

AC 230V Tritex II 75mm, TTX80-100mm 7 8
DC 48V Tritex II, TTX060, TTX080 4 6
AC 230V Tritex II 90-115mm 2 5

DC 48V Tritex I 1 N/A
EXP 3 N/A

There are three ways to connect to the drive: Scan for Active Drive Connections, Read Parameters from Drive, or Write Parameters 
to Drive from the Drive pull-down menu. These have Toolbar icons  (Scan),  (Upload), or  (Download) respectively. If 
multiple actuators are available on a network, a pop-up will list them and ask which one to connect. The Network Manager window 
is generally not needed after making a connection and may be closed. The three ways to connect differ only in how parameter data 
transfers at the start the connection.

An application and drive file must be opened to establish an online session with a drive. If the actuator drive type matches the application 
drive type, the data in the actuator can be uploaded and viewed. The Network Manager page allows scanning for all actuators connected 
to a network and shows the Drive Type by number. This may be used to verify that the actuator is of the correct Drive Type to match the 
application.

5.3.1 Using Parameter Set in Actuator

For most general maintenance or status check purposes, any application with a matching drive type may be used. 

An application and drive file created under a previous version of Expert will not be able to support any firmware features added since the 
Expert software release. It is therefore important to install the latest Expert software package and to upload from the actuator into a new 
application created with the latest Expert.

After opening or creating an application and connecting to the actuator, click on the  button or select Drive → Read Parameters 
from Drive. If there are unsaved changes in the drive file, which is not likely in this scenario, Expert will prompt the user to save 
the drive file before uploading the new parameters. Be aware this prompt refers to the parameters in the drive file before bringing 
up the parameters from the actuator. Then Expert transfers Factory (System) parameters from the actuator into the open drive file 
followed by all the User parameters, overwriting anything that had been in the drive file. The actuator remain active online. If this 
was an existing application, it is wise to save the new parameters under a different name using the File-> Save-> Application As… 
command to avoid overwriting the source. Whether a new or existing drive file, it is also wise to save the drive file under a new 
name specific to the actuator using the File-> Save-> Drive File As… command. 

At this point, the user has visibility to all display parameters and most Factory (System) parameters and full control of all User 
parameters to configure operation. Most display parameters update continuously to show the status of the drive.

If a parameter changes as the result of an Upload operation, the value will turn ‘red’, which indicates the parameter changed but 
the drive file has not been saved. This can be very useful to see what parameters differ between the parameters in the drive file 
and those in the actuator. Open a drive file that should closely match the actuator. Do an upload and look for red parameters. 
Close the drive file without saving to preserve it, or do a “Save As…” operation to save both. Any red parameters will return to 
normal ‘black’ when the drive file is saved, or in the unusual case of an Upload operation following a Download operation. Display 
parameters generally do not turn red because the values are “live” and not saved anywhere.
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5.3.2 Using Parameter Set from an Existing Drive Application and Drive File

This method downloads User parameters from Expert to the actuator and remains active online. Use this to load the entire 
set of operating parameters for an actuator for a particular job. Parameters that are unique to an actuator such as tuning, 
communications, Drive ID and name, calibration, and all factory parameters do not transfer to the actuator.

The most common use of this is to clone actuators from a master application and drive file, or to start with an existing application to 
make modifications for a new use. If a master file, both the application file (ending in .eapp) and drive file (ending in .edrv) should 
have Windows file attribute set to Read Only to prevent accidental modification.

After opening the desired application and drive file, select Drive → Write Parameters to Drive or click on the  button. At the 
end of the download, the actuator saves the User parameters to NVM so they may be reloaded on each actuator power cycle.

After downloading the User parameters to a particular actuator, it is best to upload from the actuator, which brings up all the 
factory parameters and other parameters that do not change with a download. Save this application as a complete record of the 
parameters in this unique actuator, with a unique name, such as including the serial number in the name. Alternatively, if there are 
many actuators that do the same job, multiple drive files with unique names may be saved with a single application.

5.3.3 Connecting Without Transferring Parameters

This method establishes communication with the actuator only (goes active online). Its primary function is to quickly go active 
online to view the fault status. It is important to note that this can cause confusion because it is possible that the remaining 
parameters may be mismatched.

Select Drive → Scan for active Drive Connections or click on the  button. 

No configuration parameter data transfers when this connection is established. The parameters shown on Expert pages 
may not match those in the drive until an upload or download has been performed.
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5.3.4 Changing RS485 Modbus RTU Communications

A final note on connections and communications is that the RS485 Modbus page allows the user to set the actuator communication 
parameters to match the requirements of the communication network, usually to set the network for proper connection to a PLC or 
other control device. Expert has to meet the actuator where it is, so this has to be done while operating on the set of parameters 
currently in the actuator. Since these changes are generally sent over the network that is being reconfigured, critical changes will 
not take effect right away, but will be delayed until the actuator restarts after power is cycled. Make the desired changes and click 
on Save parameters to drive for one or more actuators. Then use the Network Manger to change the Expert communications 
settings to match. Then power cycle the actuators to restart them.

Any of the following will work to bring up the RS485 MODBUS page shown below:

1. Select the RS485 MODBUS entry in the Networks group of the System tree 

2. Use the main View → Page → RS485 MODBUS menu

3. Click on the  button and select RS485 MODBUS 

Drive ID
This is the Modbus node ID. Change delayed until actuator restarted (power 
cycle).

Baud Rate
This is the baud rate for serial communications. Change delayed until actuator 
restarted (power cycle).

RX Timeout

This is the additional time beyond the standard “1.5” character time before a 
receive command “times out”, also called the inter-character gap. Modbus mas-
ters should be able to send messages without significant gap and the value can 
remain 0. Some PC’s may occasionally introduce gaps, requiring a non-zero 
value for reliable communications.

RX to TX Delay

This is the delay time between when a command is received, and the response 
is transmitted. Typically set to 0, but some Modbus masters may hold the net-
work for a while at the end of a message, requiring a non-zero value for reliable 
communications.

Parity

This sets the parity type, Even and Odd Parity require one stop bit, and No 
Parity requires two stop bits from the master. These settings must match the 
settings in the Modbus master, usually the PC running Expert software, see the 
Port Settings section for Expert above. Change delayed until actuator restarted 
(power cycle).

Changes to the critical parameters will not be sent to the drive unless the Save parameters to drive button on this page is pressed. A 
normal download will not write these parameters to the drive. This allows a drive file prepared for any Drive ID to be downloaded to the 
connected drive without changing the Drive ID.
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6. SETTING UP APPLICATION PAGES
6.1 CONFIGURING THE USER INTERFACE
Expert software has different views, called pages, to configure motion, control operation, view status, and see diagnostics. Pages 
may be displayed in countless arrangements, so the following is one found to be very useful in developing and configuring motion. 
The start-up default shows the Toolbar at the top, System Panel docked on the left edge, Status page docked bottom center, and 
Status Bar along the bottom with those elements highlighted. This example also shows the Input Function Control and Output 
Function Status pages docked on the right and the Jog page in the main body.

 

Use the View drop-down menu to show or hide the special bars and panels by clicking on the name. Pages may also be shown 
from the available pages sub-menu shown expanded here, though these are generally selected from the System Panel.

Clicking on  in the top right of docked page or the System Panel will dismiss the page or panel. It only appears on 
panels or docked pages. Most pages appear one at a time in the main body of the window, where the Jog page is 
shown in the example above.
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6.1.1 Toolbar

The Toolbar contains icons for commonly used actions. These were presented in section 3.1.

6.1.2 System Panel

Most pages are shown on the System Panel to the left, grouped into categories, organized so that as the actuator is configured; the 
user will start at the top and work down the list. The system panel will be the most common way to view and dismiss pages.

Most pages in the System Panel appear in the main body area one at a time. Clicking on a page name will show the page, or if 
already showing will dismiss it. If a page already appears in the main body and the user clicks on a different page that also shows 
up in the main body, the first page will be dismissed and the new page will replace it.

Not all available pages show up in the System Panel. Some ordinarily appear only from other pages such as the Moves 
Maintained page accessed from a button on the Input Function Control page. Others are seldom used, such as I/O calibration. 
These pages generally appear as floating windows rather than in the main body area.

6.1.3 Status Bar

This will show the application file name, the type of drive connected and the status of the drive.

6.1.4 Displaying Other Available Pages 

For viewing any available page, select View → Page → drop-down menu or click on the  button. An available page is one 
that is in a list in the application file and has a page file in the Page Files folder in the application folder. When creating a new 
application, the list and the page files are aligned.

Though possible to view any additional page through the File → Open → Page…, menu and navigating to the page, this is only 
temporary and not integrated into the application. It is best to either include all pages when creating a new application or adding 
the page to the application as explained later.

6.1.5 Controlling Page Display

For viewing any available page, select View → Page → drop-down menu or click on the  button. An available page is one 
that is in a list in the application file and has a page file in the Page Files folder in the application folder. When creating a new 
application, the list and the page files are aligned.

If a user right clicks in the base area of a display, a menu appears as with Hide 
Page as first entry. If something else appears, try right clicking close to the page 
border. The view at right follows the Show Page As… entry and choices for the 
Docked selection. A Tabbed Page appears in the main body area which is how 
most pages appear. A Floating Window and Free Floating Window appear as 
completely separate windows on top of the main window and can be moved 
around. A Docked page will appear on the selected edge of the main window and 
stay there until dismissed. These properties are saved with the page when the 
application is saved.

Also pertinent to page appearance is the bottom of the Page Properties window 
that appears when clicking on that entry. AutoScroll allows a page larger than the 
main body area to scroll as needed to see the entire page. Detail Page simply 
means it does not appear until requested. Show in page drop-down lists means it 
appears in the System Panel.
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The default settings were considered carefully to provide easy use and navigation around the Expert user interface, so this section 
provides information on why pages appear as they do and where to access controls for customization.

It is possible to create custom pages with custom displays and buttons with scripted actions accessing any of the parameters in the 
drive file. However, this is beyond the scope of this instruction manual.

6.2 ADDING PAGES TO AN APPLICATION
As mentioned in 6.1.4, the best way to assemble the correct set of pages is when creating a new application. This can be done at 
any time and can be used to update an application to the latest pages and drive file and uploading parameters from a connected 
actuator.

Pages may also be added, deleted or hidden by selecting File→Application Properties and then clicking the Pages tab. What 
appears is a smaller version of the Pages tab for creating a new application. It only shows the available pages. The arrows can 
be used to re-order how they appear in the System Panel and lists, and the Remove button deletes a highlighted page in the 
list. Clicking the Add button brings up a navigation window to find a page to add. Pages differ based on Drive Type and firmware 
version supported, which is why creating a new application from the latest Expert installation is recommended. A page added this 
way is copied into the Pages folder and added to the list in the application file so becomes fully integrated into the application. The 
application must be saved to keep the changes. 

6.3 MAKING CHANGES TO ACTUATOR PARAMETERS
How a Tritex actuator controls motion through specific commands is through a carefully constructed set of configurable parameters. 
Many of the pages in the Expert user interface provide enterable fields to make changes to parameters. The user changes actuator 
parameters by typing in new values in an “EditBox” or selecting from a list of options in a “SelectBox”or clicking on a “CheckBox” 
to toggle it. Fields that can be changed have a white background. “Monitor” values are read-only so are not white, and Factory 
parameters are normally not white to prevent user changes to this critical set of parameters.

When a numeric or text parameter has been typed to make a change, the change is not accepted until focus is moved by clicking on a 
different parameter or using <Tab> to move to the next parameter or pressing <Enter>.

When a parameter on the screen is changed, the text turns ‘red’, but the new value is generally NOT sent down to the actuator 
until a download. Often the user enters multiple parameters and sends and saves all changes at once with a download. A few 
take immediate effect such as Jog controls and tuning. To force a parameter change immediately, right click on the entry field 
and choose Write current value to connected drive from the pop-up menu. Most parameters do not continuously update from the 
actuator either. If ever in doubt about the value in the actuator, right click on the parameter and select Read value from connected 
drive. Most parameter changes take effect when sent, but a few only take effect when the actuator is restarted. One final note on 
changing parameters is that most CheckBox parameters are single flags (or bits) within a 16-bit or 32-bit parameter. All 16 or 32 
bits are read or written at the same time even when it is not obvious how flags are grouped.

Even though a parameter is entered, downloaded and active in actuator RAM memory, parameters are NOT saved to actuator non-
volatile memory (NVM) until a Download operation or Write Parameters to Drive command executes, which downloads most parameters 
and saves to NVM. Parameters sent to the actuator without a Download operation will revert to the last value stored in NVM when logic 
power is cycled.

To save changes in the drive file select File → Save → Drive File or click on the  button. After this the parameter values will 
return to the ‘black’ color. Often the user concentrates on saving parameters in the actuator and forgets to also save the drive file. 
There is a prompt on exit.

6.4 MOUSE RIGHT CLICK FEATURE
Right-click on an entry field or control button to bring up a menu with features that depend on the parameter or control. The right-
click menu for the Fast jog speed EditBox is shown on the right, while the one for the Jog(-) button is on the left.
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The Write… and Read… commands were mentioned in the previous paragraphs.

The menu on control buttons has an option for latched or momentary operation. The Latch… and Don’t latch…lines operate as a 
pair of radio buttons where clicking on a line sets that option and unsets the other. 

Some menus have a View Helpfile feature to provide more information. Clicking on this opens a .pdf of the relevant page from the 
Tritex II Parameters Manual.

The Modbus ID is also commonly present. It simply shows the Modbus number for the parameter and has no function when 
selected. It is a simple way to find the Modbus number for a parameter when setting up a PLC.

The EditBox Properties or CheckBox Properties selection brings up additional windows into the inner workings of the Expert User 
Interface. These details are beyond the scope of this manual.

It is highly recommended to NOT attempt to edit properties.

6.5 HELP DOCUMENTS
Click on the Help → Documents to view various manuals that are included with the software, including the installation manuals for 
all the actuator models and information on Ethernet based communications.
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7. SETUP PAGES
An important step in setting up a new application is to understand and address all pages and parameters in the Setup group of 
pages. These pages provide the framework for viewing motion, limits of various types, exception handling, and operating mode 
selection.

7.1 USER UNITS
User units provide a way to show motion in a way that makes sense. Internally, Tritex uses fixed point math with scaling to make 
numeric ranges fit in 16-bit or 32-bit integer values for efficient storage, calculation, and transfer in Modbus registers. Obviously this 
has little meaning outside the little world of the microprocessor in the actuator. For instance the internal unit of distance is 1/65536 
of a revolution, which means that a 32-bit value representing position uses the top 16 bits as the integer number of revolutions 
(revs) of the internal motor relative to a reference position and the lower 16 bits as a fractional part of a rev. The default user unit 
for position is revs and the scale factor for displaying position in revs is 1.52587890625E-5 as shown in the Scale Factor column, 
which is 1/65536. The important concept is that all parameters that represent a number are scaled to fit into Modbus registers but 
are displayed in Expert in a way that makes much more sense to the user.

Internal revs for a linear actuator is still not the most sensible way to display position, so it is possible to select main rod position 
in linear units (inches, meters, millimeters) or geared rotary position in revs of the output shaft, or even main rod position when 
driven by a geared rotary Tritex. If someone wants to see a valve actuator display in % open, or a geared shaft with ¼ turn range 
display in degrees, that can be done using the Custom User Defined units. The only requirement is that the displayed value will be 
proportional to the internal units of revs, so the final angular position of a shaft turned by a clevis mounted linear actuator through a 
crank can’t be accurately displayed, but it may be close enough. The point is that there is great flexibility in choosing User Units.

In the Setup grouping of the pages tree, select User Units. 

First, choose the type of actuator by clicking on one of the four radio buttons:

Linear Actuator 
    Then select the actuator lead from the label. This is the distance the main rod moves for each revolution of the internal motor.

Rotary Motor / Gear Motor 
    Then select the gear reduction ratio. 1:1 for a non-geared rotary, and the reduction from the model number for geared.
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Combo (Rotary + Linear Actuator) 
This is usually an FT or K series actuator driven by a rotary or geared rotary Tritex. Then select both the lead for the linear 
actuator and the gear reduction ratio for the rotary part. If there is some other gearbox or non-1:1 belt between them, it may be 
necessary to use the Custom User Defined option.

Custom User Defined 
If starting at 0 for the value to display for position in whatever units desired, imagine the internal motor turning 1 rev. Calculate 
what value should now display for position in those units as the motion transfers through whatever gears, belts and pulleys and 
roller screws there may be between the motor and the final motion. Enter this value in the User Units per 1 motor revolution 

When this section is done, click on Apply. 

Next, select the units from the available selections and number of decimal places of precision from available selections for 
distance, velocity, and acceleration. The available selections differ based on actuator type. Note that revs, rpm, and rpm/sec 
are available even with linear motion in case the perspective of internal motor revs is useful. Display Text will appear when units 
are selected, but can be modified if desired. For the Custom User Defined option, the only selection for position units is “User 
Units”. Make that selection and then type in the desired Display Text. Velocity units are frequently available as “per second” or “per 
minute”. Choose whichever makes the most sense.

As the choices are defined, the values in the Scale Factor column change. The value for a Modbus parameter that represents 
position or distance is multiplied by the scale factor for distance to appear in the desired units. Similarly, parameters that represent 
velocity and acceleration use the corresponding scale factors. The value for the Modbus parameter does not change when units 
and hence scale factors change. These are display factors only and the actuator knows nothing about them. They are saved in the 
Drive File but never sent to the actuator. As an unfortunate consequence, if you create a new application the User Units are lost, 
reverting to defaults, and have to be set up again. It is always a good idea to keep a copy of the drive file for each actuator handy.

Finally, choose whether to display motor current in Amps or Percent of rated current. The default is units of Amps with a display text 
of “AMPS”. When using percent of rated current the relevant area of the User Units appears below.

 

The recommended value is the real rated current for the actuator in use found on the Factory Parameters page, Limits tab as 
Continuous Current. The real rated current value determines the current for a Continuous Current fault and the Over Rated Output 
Status flag, so displaying this value as 100% has significance to actuator operation. When using Percent for current display and 
Current for 100% is not the Continuous Current limit value, a pop-up will appear offering to fix it each time the user connects and 
goes online with the actuator. This is handy if the intent is to use this value because it may not be known before going online. If 
choosing Yes, the Current for 100% value will be changed to match the actuator with immediate effect, and will be saved when the 
Drive File is next saved.

However, any value may be used here, if some other value has more meaning in the application. For instance, a value based on 
your User Current Limit may be preferred. Keep in mind that this does not change the actual motor current used to determine the 
Continuous Current fault. The user will have to put up with the pop-up request to change the display value on each occasion to go 
online.
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7.2 SYSTEM SETUP PAGE
The System Setup page has eight tabs to group the large number of parameters into functional groups. The following sections 
describe each tab.

7.2.1 Options Tab

Quick Reference for Options Check Boxes
Option Checked Not Checked

Auto-Enable on Start-up
On power-up, the drive will automatically enable 
after Power-up Delay if no disabling faults are 
active. After that normal state is enabled.

Additional Enable signal or command 
required to enable drive.

Always enable Teach 
input functions

Teach inputs are always active. For more 
information see Valve Application section.

Teach inputs are inactive unless Teach 
Enable input function is active.

Allow Jog override of 
Default Mode operation

A Jog command will take precedence over most 
other Default Mode motion commands. Jog 
will NOT override a Dedicated Move or Home 
command.

A Jog command will not be honored 
while another motion command is 
active in Default Mode.

Allow Jog override of 
Alternate Mode operation

A Jog command will take precedence over most 
other Alternate Mode motion commands. Jog 
will NOT override a Dedicated Move or Home 
command.

A Jog command will not be honored 
while another motion command is 
active in Alternate Mode.

Reverse direction polarity 
(Extend/CW = negative 
direction)

Reference direction is positive motion retracts 
main rod for a linear actuator or turns shaft CCW 
(looking at shaft) for a rotary actuator.

Reference direction is positive motion 
extends main rod for a linear actuator 
or turns shaft CW for a rotary actuator.

Stroke Calibration 
Required

Motion other than Stroke Calibration is inhibited 
unless Stroke Calibration Complete flag is set. For 
more information on Stroke Calibration see the 
Valve section of this manual.

Stroke Calibration Complete is 
ignored, allowing normal motion.

Foldback at continuous 
current limit

If the value of the Continuous Current parameter 
exceeds the Continuous Current Limit value, the 
current will be limited to the Continuous Current 
Limit value until Continuous Current drops 
below 80% of the continuous current setting. A 
continuous current fault will not occur.

If the value of the Continuous Current 
parameter exceeds the Continuous 
Current Limit value, a Continuous 
Current fault will occur, disabling the 
drive.

Disable Absolute Hall

Multi-turn absolute feedback (if present on the 
actuator) will be turned off, and the actuator will 
generally have to be homed after each power-up. 

Multi-turn absolute feedback, which 
is on all TTX series actuators and 
any others with –AF in the model 
designation, will be active. 

The following paragraphs provide additional information on some options above.
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Auto-Enable on Start-up - 
With this option checked, the drive will generally be enabled unless faulted or a Disable command is active. It is equivalent to 
applying the Enable (Maintained) command all the time. If an option to disable at the end of a move is configured and that event 
occurs, the drive will disable and require a new edge on Enable Momentary to re-enable. Without a logic supply to keep the 
processor active, applying main power causes the actuator to go through its power-up sequence and with this option checked 
will enable the drive when the Power up delay time has elapsed.

Overall machine safety must be considered in determining whether to use the Auto-Enable on Start-up option or to require a 
separate enable signal or command.

Reverse direction polarity 
The entire direction reference for the actuator reverses by changing this option. The definition of any absolute position is lost with 
a change. Therefore, the Homed output function flag is automatically cleared. A Home command is required to resume operation. 
It is best to determine and set the reference direction before configuring motion.

Changing this option is disruptive. Change it only when actuator is disabled. After making and saving the change to NVM, 
usually with a Download, you must restart (cycle power) to the actuator, to complete the change. Do not dynamically change 
this parameter, treat it as a one-time part of initial set-up.

Foldback at continuous current limit 
Many applications should fault when the average current exceeds the rated value for the actuator to prevent overheating. It 
usually indicates something is not running properly and needs maintenance. Some applications should continue trying to operate 
but at reduced motor current. This will generally reduce the speed it can move but will prevent damage to the actuator due to 
overheating. Valve actuators are examples where continued operation may be best.

Disable Absolute Hall 
NEW! If a user prefers not to use the multi-turn absolute feedback feature but it was installed on an actuator, there was no easy 
way to turn it off. Now that the Tritex TTX series comes standard with the feature, the option was added. When disabled, the 
battery is not needed and may be removed, however, the battery monitor remains active. The Abs Hall Battery condition should 
be configured on the Fault Enables tab to ignore the low battery condition. Of course after disabling multi-turn absolute feedback, 
the actuator will need to be homed on each power-up.

The remaining parameter on this tab is the Power-up delay. The purpose of this parameter is to allow other components of a 
system that power up at the same time, such as a PLC or other controller, to get up and running before the Tritex is operational. 
This time is in addition to the approximately 1 second time to start up the processor on power-up. Enter the additional power-up 
delay time in seconds. All functions are inhibited during this time including communications, though an Ethernet connection may 
establish but not have new data.
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7.2.2 Fault Enables Tab

The Fault Enables tab of the System Setup page is used to configure the reaction to some exception conditions detected by 
the fault handling system.  Not all conditions appear in the list since several conditions like high bus voltage or peak current are 
not configurable. Those conditions always disable the drive and by default enter the occurrence in the status log. The exception 
conditions in red remain in the list but are no longer configurable to better protect the actuator.

For a more complete description of the fault handling system, refer to the section on the Diagnostics page. The system detects 
exception conditions and initiates actions based on the condition. If the action disables the drive, it is called a “fault” and also sets 
the Faulted Output Function Status flag. Conditions configured with a check in the WARN column will generate a “warning” and set 
the Warning Output Function Status flag. When a condition with a check in the Log column occurs, it is entered in the Status Log. 
Refer to the section on the Status Log page for more information about that diagnostic tool.

Continuous Current, Board Temperature and Actuator Temperature faults are there to protect the actuator. Until 2017 these conditions 
could be configured to take action other than a fault that disabled the drive, assuming the action would reduce the temperature or current. 
For a variety of reasons, the only action that fully protects the actuator is immediate fault on these three conditions. Both Expert software 
and the drive firmware enforce this change.

The following table describes the configurable actions for exception conditions, which can be combined in some cases.

STOP
Issues a Stop command to stop motion, decelerating using the Stop Ramp parameter on 
the Limits tab. The Stop command is removed by first clearing the fault condition and then 
waiting for the Fault reset delay to expire or issuing a Reset Faults command.

MOVE

Causes the Dedicated Move to activate, moving the actuator to the configured Dedicated 
Move Position. If the fault condition clears and then the Fault reset delay expires, normal 
operation will resume even if this occurs before the move is complete. (See Dedicated Move 
section for more details.)

DISABLE

Causes the drive to disable on the selected exception condition. The drive must be re-
enabled after the fault condition has cleared by re-applying an enable signal or sending a 
Reset Faults command while holding an enable signal active. Re-enabling after a fault does 
not happen automatically. The Fault reset delay does not apply because an auto-reset is not 
allowed when DISABLE is selected.

WARN
Causes a warning status and the Warning output function to become active. The Warning 
will clear when the fault condition clears.
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With more than one action selected, they are executed in the following sequence:

1. WARN  2. STOP or MOVE  3. DISABLE 

Example 1:  MOVE and DISABLE are both checked for a Loss of Signal fault. First, the Dedicated Move would take place. When 
it is completed, the drive will disable. Fault status indications are active during the move and while the condition per-
sists and until re-enabled or reset. Dedicated Move Active status flag is active during the move.

Example 2: STOP and DISABLE are both checked for a Loss of Signal fault. First, a Stop would take place. When it is completed, 
the drive will disable. Fault status indications are active during the stop and while the condition persists and until re-
enabled or reset. Stopped status flag is active until the drive disables.

Example 3: MOVE, DISABLE and WARN are checked for a Loss of Signal fault. Action is like Example 1 except Warn status 
indications are active while the exception condition persists. Making both Warn and Fault status available can provide 
a more complete picture of the state of the actuator.

It is not useful to configure both STOP and MOVE for one condition. STOP takes precedence, so the MOVE will not execute.

The following table describes the different exception conditions.

Continuous Current

The drive continuously monitors motor current using a modified I2t calculation to model 
power dissipation in the drive and motor. The result is filtered and compared to the 
Continuous Current value shown on the Factory Parameters page and generates a fault 
if it exceeds the trip point. The value appears on the Monitor page as Continuous. The 
trip point is set for each model and represents the maximum allowable time averaged 
operating point for the actuator. It must be set to Disable and should be logged. The 
cause of repetitive occurrences should be investigated and corrected.

Move Termination
A Move can be configured on the Move Setup page to generate this exception condition 
if a move terminates in an unintended way. For example, if a move goes into current limit 
before getting to the end position, or the other way around.

Following Error

This exception condition occurs if following error exceeds the Max Following Error for 
more than the Following Error Time Limit configured on the Limits tab. This frequently 
indicates a machine jam, or attempting to operate beyond speed or acceleration, or 
“loose” tuning on quick moves.

Board Temperature
This fault condition occurs when the drive electronics temperature exceeds the trip point 
on the Factory Parameters page. It must be set to Disable and should be logged. The 
cause of repetitive occurrences should be investigated and corrected.

Actuator Temperature

This fault condition occurs when the temperature sensor in the stator winding indicates 
the temperature of the stator is over the factory limit. Some older actuators had thermal 
switches, but all units in production now have temperature sensors. The cause of 
repetitive occurrences should be investigated and corrected.

Loss of Signal
This exception condition occurs when the Analog Input value is out of range. It is set up 
on the Analog I/O or IA4 Option Board page, Input Setup tab. The relevant parameters 
are the Low Trip and High Trip values and associated Enable check boxes.

Communications
This exception condition occurs when the Tritex loses communication on one of the 
communications ports. .

User Low Bus Voltage
This fault condition occurs in DC drives when the user sets a low bus voltage limit, and 
the bus voltage drops below that limit. (Not shown in example above.)
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Abs Feedback Rollover
This fault condition occurred on actuators with an old absolute feedback design when the 
turned more than +/-8192 revs. The turns limit was removed in August 2016 on all new 
units, so this fault will no longer occur.

Abs Hall Battery
This fault condition occurs on drives that use an absolute feedback device when the 
absolute feedback battery voltage droops, indicating battery replacement is needed 
soon. It is generally set to WARN since it is an early warning fault.
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The following table describes the remaining parameters on the Fault Enables tab.

Fault reset delay
1 This time delay is added before automatically recovering from a fault condition. This 
feature is only effective when DISABLE is NOT selected.

Example: The delay is set 3000ms (3 sec). The Loss of Signal fault is set to perform a STOP. On a Loss of Signal condi-
tion, the Stop mode would immediately be activated, and remain until the Loss of Signal condition is rectified. Then, after a 3 
second delay, operation will continue.

Fault Log Delay
This time delay is to avoid logging false faults during a normal power down, such as Low 
Bus voltage. (See Status Log page section)

Auto Reset on  
Low Bus Voltage Fault

2 If this checkbox is set, a Low Voltage Fault will clear automatically when the voltage 
rises to 110% of the Low Voltage Trip value. This parameter does not apply to the User 
Low Bus Voltage fault.

1 If DISABLE is checked, there is no automatic fault recovery; the fault is latched, and the drive will remain disabled until a reset 
occurs or the drive is enabled again, and the fault condition is removed. If DISABLE is not checked, the drive will automatically 
recover when the fault condition clears and after the Fault reset delay time has expired.

There are many details in how the exception handling system works. It is best to thoroughly test out the configuration to make sure 
it provides acceptable responses to foreseeable events. Here are some additional notes on configuring faults and warnings.

There are no general provisions to create a warning when a temperature or continuous current approaches the trip point. A 
Comparator can be configured for this purpose and may be used to initiate a Dedicated Move. The underlying parameter can also 
be monitored over a communications link to alert a PLC or similar controller.

Though a Continuous Current fault will always disable the drive immediately, the Foldback at Continuous Current limit option may 
provide a way to avoid a fault while still protecting the actuator.

A Dedicated Move or (rarely) a Stop must be able to finish the trajectory calculated for it at its onset or the actuator could hang 
up and not go on to the Disable stage. If a jam prevents the Dedicated Move from getting to the end position or a Stop from 
completing a decal ramp, the action will not complete and could remain in a high current state indefinitely. The solution was to 
prohibit use of Continuous Current, or overtemperature conditions with STOP or MOVE actions.

Please see the section on the Status Log and Diagnostics page for additional information on faults.

7.2.3 Comms Faults Tab

The Comms Faults tab is used to set up the conditions that will be monitored to determine a host communication exception 
condition. The Fault Enables tab settings control the action taken on occurrence.

Channel A is dedicated as the RS-485 port included on all models. Channel B is used with the Ethernet based advanced 
communications protocols, including EtherNet/IP, PROFINET, and Modbus TCP/IP. The Channel B communication fault identifies if 
there is an issue with the communication interface, but does not indicate associated protocol errors. 
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Comms Fault Power-up Time

This sets the time delay at start-up before communication faults are monitored. This 
allows time for the host controller to power-up and establish communications, prevent-
ing unnecessary faults at start-up. The Power up delay parameter on the Options tab 
also provides delay, but sometimes this parameter alone or in combination provides best 
start-up sequencing depending on the system.

Command Idle
If a valid command from the host has not been received in the time entered, this fault 
condition will be set. 

Protocol

If a protocol error, such as incorrect parity, invalid CRC, framing error etc. occurs, this 
fault condition will be set. It indicates a bit error in a message, which could result in a 
NACK or an ignored message, whereupon the master may attempt a retry. It is usually 
better to ignore occasional occurrences if the master attempts a retry than to take ag-
gressive action. It may be useful for temporary diagnostic purposes.

Data Error
If a data error, such as invalid address, invalid range etc. occurs, this fault condition will 
be set. This is due to an improperly formed request from the master, so is ultimately a 
programming error that should not have to be monitored past check-out.

Module
If a module error occurs, such as invalid ID address, invalid baud rate etc. occurs, this 
fault condition will be set.

Connection

This monitors the connection when one or more of the following Modbus errors occur: 
• Command timeout

• Protocol error

• Data error

• Network error

• Module error

7.2.4 Limits
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User Current Limit

Sets the maximum current the drive will deliver to the actuator, though the Factory 
Current Limit will be enforced if lower than the User Current Limit setting. Actuators with 
firmware 3.00 and newer will have separate Current Limits for positive and negative 
directions. If the negative current limit is set to 0.0, the positive current limit will be used 
for both directions.

Max Following Error

Sets the maximum allowable following error (difference between commanded position 
and actual position). If following error exceeds this value longer than the Following Error 
Time Limit, a fault will occur. This condition is monitored for position and velocity mode 
only, NOT in current/torque mode. Default value is 0.5 motor revs. Note: Motion profiles 
should be designed such that following error is within about 0.25 motor revs under 
normal operation so that Following Error faults indicate unusual loads or machine jams.

Following Error Time Limit
This is the allowable time the following error can exceed Max Following Error before fault 
condition occurs.

In Current Limit Time

This sets the amount of time the current limit is active before asserting the current limit 
output status flag. It also applies to an internal current limit event. For example, if the 
Current Limit box is checked for the Home sequence, and is set to 5 amps, the drive 
will limit the current to 5 amps during the Homing sequence. If the Terminate on Current 
Limit box is checked, the drive will have to supply 5 A for this specified time before the 
termination is satisfied (also applies to “feed moves”).

Stop Ramp Sets the deceleration that will be used when the Stop function is activated.

Commissioning Software Tool
TRITEX® SERIESactuators



Expert™ Software Manual for Tritex® Actuators | 31www.exlar.com | 952.500.6200

7.2.5 Operating Modes

This tab allows selection of the source/motion type for Default and Alternate modes. The description of these modes of operation 
are available by right clicking on the drop box and selecting the View Helpfile. The possible selections for each mode include: 

• Inactive

• Digital Inputs 

• Analog Position

• Analog Velocity

• Analog Current 

• Host Position

• Host Velocity

• Host Current
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7.2.6 Dedicated Move

The Dedicated Move is designed to provide a method, available from any mode, to move to a specified position. The Dedicated 
Move always has priority in all operating modes. If the MOVE flag is set high at any time, during any action, the Dedicate Move will 
be executed. If the Disable drive upon completion of dedicated move box is checked, the actuator will be disable at the completion 
of the Dedicated Move. The actuator must be enabled again to resume operation.

The Dedicated Move Position is an absolute position, therefore the actuator must be homed (Homed output function on), usually by 
completing a Home Move, before a Dedicated Move will be allowed to execute.

7.2.7 In Position Window

The In Position Window defines the window and time delay used by- Home, Dedicated Move, Move (x) and In Position output 
functions-to determine the actuator at the right position. The window width is +/- the value entered. For example, if the 0.005 inches 
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is entered the actual position must be within +/– 0.005 inch of the commanded position. The In Position condition is satisfied when 
the commanded position “minus” actual position is within the window AND remains there for the specified Time To Activate, AND 
the commanded velocity is ZERO. 

In Analog Position mode, the commanded velocity is usually changing continuously, dithering in position. 
Therefore, the commanded velocity is rarely zero for very long, so the In Position output function will con-
tinually cycle on and off. 

7.2.8 Position Limits

Position Limits are software monitored travel limits, with special features for control outside of these travel limits.

The limits can be enabled individually for each direction during all modes of motion. The controller looks ahead to anticipate when/
if the position limit will be hit based on the current velocity at approximately a 2 ms scan rate. If it is determined the limit will be 
reached, the control decelerates using the acceleration/deceleration rate for the active mode. Once the commanded position is 
outside of the position limit range, the Velocity, Foldback Current and Seating Current parameters take effect. The motion control, 
while outside of the position limits, operates in a special mode to limit velocity and current. If the velocity is set to zero, motion will 
stop near the limit position; if it is non-zero, the motor will ramp to the limit velocity, without stopping until it reaches a hard stop. 
When a hard stop is hit, the Seating Current will be produced for the specified time and then the current will be switched to the 
Foldback Current value. During this Position Limit mode of operation, the Following Error does not build up when a hard stop is 
reached; instead, the Following Error is controlled to maintain the specified current limit. The limits are direction sensitive, meaning 
that velocity and current are only limited in the direction of the active position limit; any motion commanded in the opposite direction 
will operate normally. 

Exception: If the mode of operation is Analog Torque or Host Current mode, the Velocity limit will not be in effect, however, the 
Seating Current and Foldback Current limits are active.

Position Limits are only active after a Home has been completed (Homed status flag is on).
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Position Limits parameters

Enable min (-) Select the direction in which the limit parameters are active.
Enable max (+) Select the direction in which the limit parameters are active.

Absolute Position Limits
Set the position where the limits become effective. Since they are absolute positions, a 
Home must be completed before they will take effect.

Use percent of analog range

This option is normally used if the position mode is Analog Position and the user desires 
to base the position limits on the percent of the analog position min and max settings. If 
this box is checked, the specified percent of Analog Input command will be used instead 
of the Absolute position limits. This is common in valve applications.

These limits take effect when the commanded position is outside of the Position Limits parameter values.

Velocity
This is the velocity limit in user units. If set to zero, the motor/actuator will stop near the 
position limit. If set to a non-zero value, the velocity will be ramped to this velocity at the 
position limit position.

Foldback Current
The current will be limited to this value when the commanded position is outside of the 
position limit range and the Seating Current limit has been reached and the time has 
expired.

Seating Current

If a hard stop is hit while outside of the position limit range, the current will build to this 
value for the specified time. When the time has expired, the Foldback Current limit will 
take effect. If it is not desired to have extra current for seating, this value should be set 
equal to the Foldback Current limit.

If Homing to a current limit is used, the Feedback and Seating Current Limits must be set to a higher value than the Home Current Limit 
to avoid conflict when trying to perform a home beyond the Position Limits.

The method of recovery from a Position Limit condition is dependent on the motion mode that was used to enter the position limit 
range. In the following modes, any velocity or toque mode, Host Position, Analog Position, or Jog; a command in the opposite 
direction will move out of the Position limit condition. If a Move Maintained input function started a Move that caused the Position 
Limit condition the Move can be discontinued by removing that input function and any motion mode can be used to move out of 
the condition. If a Move Momentary input function started a Move that caused the Position Limit condition, the Move remains active 
until the distance or termination method is satisfied, this prevents other Moves initiated by Move Momentary input functions from 
operating. To move out the position limit condition move must be terminated, this can be done with a number of methods, A Move 
initiated by Move Maintained Input function ,Stop, Disable, Jog in the opposite direction if Jog Override is selected on the Setup 
page, Initiating a dedicated Move, or selecting Alternate Mode. 
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7.3 TUNING
Tritex default gains are set to work out of the box for many applications, for those applications that require tuning four parameters 
are provided on the Tuning page.

The drive’s proprietary motion control algorithms have been designed to reduce the number of tuning parameters for the customer. 
There are five parameters: Inertia Gain, Response, Integral, Velocity Feedforward and Velocity Damping. Only Inertia Gain and 
Response are visible by default. The others are not normally necessary to change; however, they can be made available when by 
right-clicking on the page and selecting Show Page Details.

If the actuator is online changes to the gain parameters take effect immediately, however they will not be saved in nonvolatile memory 
until Save Tuning Parameters is performed.

Do not use these parameters in combination with a high Integral value as they tend to fight each other.

7.4 FACTORY PARAMETERS
This is where factory parameters can be viewed. There are multiple tabbed windows sorting factory information.

7.5 FACTORY CALIBRATION
This is where factory calibration can be viewed. There are multiple tabbed windows sorting factory information.
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8. MOTION CONTROL
8.1 MOTION CONTROL OVERVIEW
There are two basic methods to control motion: Digital Inputs or direct control of position, velocity, or torque. The Digital Inputs 
method can control Jog, Move, and Dedicated Move and Home motion types. The direct method can control position, velocity, 
or torque directly from either an analog command or a host command. These motion control types are available in three modes: 
Default mode, Alternate mode, and Host Control. To provide additional flexibility and ease of use, Dedicated Move, Home, Jog and 
Stroke Calibrate motion types are available under certain conditions even if Digital Inputs is not the selected control method. 

Default & Alternate Mode

Default and Alternate can each be assigned a motion type, with only one type active at a 
time. Digital Inputs, Analog Position, Velocity and Torque can be selected for each. Default 
is the normally the active mode and Alternate mode can be selected via an input or via 
Modbus. For example, if Digital Input mode is selected as Default and Analog Position 
is selected for Alternate, indexing can be performed using the Move input functions and, 
as soon as the Alternate mode input function is active, the controller will switch to Analog 
Position mode.

Host Control
Host Control can only be selected via Modbus commands. Host Control allows the same 
motion types as the other modes, plus Host Position, Velocity and Torque.

8.1.1 Special Condition Motion

The Special Condition Logic allows certain motion types to be activated from input functions, even if Digital Inputs is not the current 
active mode.

Dedicated Move

If the Dedicated Move input function is activated from an input or Modbus command, it will 
override any active motion from any mode, except a Home motion. As soon as the function 
is deactivated, the motion type will revert to the active mode. A Home move must be 
completed (Homed output function on) before a Dedicated Move is allowed.

Active Motion Command
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Home

If a Home move has not been completed, a Home move can be initiated from an input or 
Modbus command, even if Digital Inputs is not the current active mode. Once the Homed 
output function is active, a subsequent Home move can only be executed when Digital 
Inputs mode is the active mode.

Jog

If the Allow Jog Override on Default Operation Mode or Allow Jog Override on Alternate 
Operation Mode check box is checked, a Jog motion will override the active motion, even 
when the Digital Inputs mode is not the current active mode. (See the Start-up tab of the 
System Start-up page for details)

8.2 HOME PAGE

8.2.1 Home Parameters

Direction Select Positive or Negative direction; Positive is the default.

Velocity
This is the Home move maximum velocity. This may or may not be achieved, depending on the 
distance traveled and acceleration parameter.

Acceleration The acceleration ramp used during a Home move.
Deceleration The deceleration ramp used during a Home move.

Current Limit

1 This sets the current limit for the Home move when the box is checked. If the Terminate on 
Current Limit box is checked, the Home move will terminate when the motor current is equal 
to or greater than this value. (The time to satisfy a Terminate on Current Limit condition is 
determined by In Current Limit Time parameter on the System Setup page). If the Terminate 
on Switch Active box is checked and the Current Limit box is checked, and the current value 
is exceeded before a switch is found, a Switch is Not Found Fault will occur. (See Faults & 
Warning)

Terminate on Current Limit/
Switch Active

This action will end the searching portion of the Home move. A specified current limit AND/OR 
switch (1-16) input function, can be used to terminate the Home move.

8. MOTION CONTROL
8.1 MOTION CONTROL OVERVIEW
There are two basic methods to control motion: Digital Inputs or direct control of position, velocity, or torque. The Digital Inputs 
method can control Jog, Move, and Dedicated Move and Home motion types. The direct method can control position, velocity, 
or torque directly from either an analog command or a host command. These motion control types are available in three modes: 
Default mode, Alternate mode, and Host Control. To provide additional flexibility and ease of use, Dedicated Move, Home, Jog and 
Stroke Calibrate motion types are available under certain conditions even if Digital Inputs is not the selected control method. 

Default & Alternate Mode

Default and Alternate can each be assigned a motion type, with only one type active at a 
time. Digital Inputs, Analog Position, Velocity and Torque can be selected for each. Default 
is the normally the active mode and Alternate mode can be selected via an input or via 
Modbus. For example, if Digital Input mode is selected as Default and Analog Position 
is selected for Alternate, indexing can be performed using the Move input functions and, 
as soon as the Alternate mode input function is active, the controller will switch to Analog 
Position mode.

Host Control
Host Control can only be selected via Modbus commands. Host Control allows the same 
motion types as the other modes, plus Host Position, Velocity and Torque.

8.1.1 Special Condition Motion

The Special Condition Logic allows certain motion types to be activated from input functions, even if Digital Inputs is not the current 
active mode.

Dedicated Move

If the Dedicated Move input function is activated from an input or Modbus command, it will 
override any active motion from any mode, except a Home motion. As soon as the function 
is deactivated, the motion type will revert to the active mode. A Home move must be 
completed (Homed output function on) before a Dedicated Move is allowed.

Active Motion Command
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Home Offset
The Home Offset is a distance moved after a termination condition is satisfied. Typically it is 
used to move from a hard-stop when Terminate on Current Limit is used. If no offset is desired, 
enter “0”.

Offset Velocity The velocity used during the offset portion of the move.
Final Home Position The commanded and actual positions are set to this position at the completion of a Home move.
Auto Home on Enable If this box is checked, a Home move will automatically be performed on enable.
Require Home before Default/
Alternate Mode operation

If checked requires a Home to be completed before operation from the Default/Alternate mode 
operation.

1 If the Current Limit box is checked, and the Terminate on Switch Active box is checked, do NOT select both Auto Home on 
Enable and Auto Enable on Start-up (System Setup page). If the actuator is against a stop in the home direction, each time the 
fault is attempted to be cleared another home against the stop is executed creating another fault.

8.2.2 Home Initiation

The Home move can be initiated from the following methods:

1. The Home input function from an assigned digital input
2. Input Function Control page
3. Home button on the Control page
4. From a host using a Modbus command
5. Automatically Home when the actuator is enabled if the Homed status in not active.

Once initiated, the acceleration rate will be followed to achieve the specified velocity. The Home termination selection is poled at a 
2ms rate looking, for a termination condition to be satisfied. Following the termination, the Home Offset move is executed. Then the 
Final Home Position is applied.
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8.3 JOG PAGE

8.3.1 Jog Parameters

Fast 1 The Jog velocity when Jog Fast is selected.

Slow 1 The Jog velocity when Jog Fast is not selected.

Accel 1 The acceleration and deceleration ramp used in Jog mode.

Jog Fast checkbox When checked the Fast velocity is used, unchecked uses the Slow velocity.

Jog using position limit 
foldback current

This flag limits the available current when a Jog motion is active to the Foldback Current 
value set on the Position Limit tab of the System Setup page. This can be used to find 
hard-stop positions or limit available torque/force during manual operation.

1
Jog Fast, Slow and Accel slider bars provide an easy way to change Jog parameters; these changes take effect immediately 
but are not saved permanently until a download is performed.

The slider bars provide an easy way to change Jog parameters; these changes take effect immediately but are not saved 
permanently until a download is performed. The Jog (+) and Jog (-) buttons will activate a Jog if they are held down with a mouse 
click. The indicators next to the buttons illuminate when the Jog is active.

8.3.2 Jog Controls

The Jog (+) and Jog (-) buttons will activate a Jog if they are held down with a mouse click. The indicators next to the buttons 
illuminate when the Jog is active. Selecting the Jog Fast check box or an input function will toggle the Jog Fast velocity. 

Acceleration

Home Offset
The Home Offset is a distance moved after a termination condition is satisfied. Typically it is 
used to move from a hard-stop when Terminate on Current Limit is used. If no offset is desired, 
enter “0”.

Offset Velocity The velocity used during the offset portion of the move.
Final Home Position The commanded and actual positions are set to this position at the completion of a Home move.
Auto Home on Enable If this box is checked, a Home move will automatically be performed on enable.
Require Home before Default/
Alternate Mode operation

If checked requires a Home to be completed before operation from the Default/Alternate mode 
operation.

1 If the Current Limit box is checked, and the Terminate on Switch Active box is checked, do NOT select both Auto Home on 
Enable and Auto Enable on Start-up (System Setup page). If the actuator is against a stop in the home direction, each time the 
fault is attempted to be cleared another home against the stop is executed creating another fault.

8.2.2 Home Initiation

The Home move can be initiated from the following methods:

1. The Home input function from an assigned digital input
2. Input Function Control page
3. Home button on the Control page
4. From a host using a Modbus command
5. Automatically Home when the actuator is enabled if the Homed status in not active.

Once initiated, the acceleration rate will be followed to achieve the specified velocity. The Home termination selection is poled at a 
2ms rate looking, for a termination condition to be satisfied. Following the termination, the Home Offset move is executed. Then the 
Final Home Position is applied.
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The Jog function can be initiated from the Jog +/- input functions, which can be activated from the assigned digital inputs, Input 
Function Control page, Jog buttons on the Jog page or the Control page, or from a Modbus command. Jog can be selected to 
override other motion types as well. (See the System Setup page description and Motion Description section).
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8.4 MOVE SETUP PAGE

The Tritex II drives can store and control up to sixteen move profiles referenced by Move (0-15). Each move has two parts: a Main 
Motion and a Secondary Motion. The Main Motion transitions into the Secondary Motion without coming to a stop. If the Enable 

Secondary Motion check box is not selected, the Secondary Motion is disabled.

Main move with secondary motion disabled.

Main move with secondary motion enabled. 

The secondary move Acceleration and Deceleration velocities will be the same as the main move velocities.

Deceleration parameter is not available on EXP 24, Tritex II AC with firmware revision older than 2.13 or Tritex II DC Tritex with firmware 
older than 2.29
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8.4.1 Move Setup Parameters 

Move Select the Move (0-15) for defining the below parameters.

Enable Secondary Motion
An optional Secondary Motion can be used to perform a move after the Main Motion move 
is completed. The Secondary Motion has the same options as the Main Motion move.

Move Type Select the type of move here. The types are defined below.

Absolute Position Move to the desired position relative to home.

Incremental Distance

Move a specified distance each time the move is initiated. If Incremental move type is 
selected, do not use the Move Maintained Input Function because as soon as the move is 
complete, another one will immediately start. Move Momentary Input Function should be 
use for Incremental type moves.

Unlimited (+/-)
Move unlimited in the positive or negative direction until a limit is reached, there is a 
command to stop, pause or disable, or a termination condition is reached.

Absolute (+/- dir only)
Move to the desired position relative to home only if the position is more positive or more 
negative than the current position respectively.

Position/Distance Defines the move position or distance specified in user units.

Velocity Defines the velocity of the move in user units.

Acceleration Defines the acceleration of the move in user units.

Deceleration Defines the deceleration of the move in user units.

Limit Current Select the check box to limit current for a given move.

Terminate on current limit 1 Terminate the move when the current limit is reached.

Terminate on switch  
active / rising

1 Terminate the move when the Termination Switch switches to active / rising state.

Terminate on switch 
inactive / falling

1 Terminate the move when the Termination Switch switches to inactive / falling state.

Fault if not terminated by 
switch or current

2 Issue fault if not terminated by switch or current

Fault if terminated by switch 2 Only selectable when Terminated on switch is selected. Issue fault if terminated by switch.

Fault if terminated by current 
limit

Issue fault if terminated by current limit

Primary / Secondary 
Velocity Override

Allows for the defined move velocity to be overridden with an external analog input or 
Modbus value. (See Velocity Override Page for more information) (Not available with all 
firmware versions)

Current Limit Defines the current limit value for a given move.

Wait for In Position
Check this to wait for the In-Position Window (Setup Page) to be satisfied before Auto 
Starting Next Move (above).

Termination Switch Defines which switch to terminate the move on if a Terminate on Switch option is checked.

Auto-Start Next Move
Check this box to “string” moves together and select from the drop-down menu which move 
to proceed to after the current move is completed. If a Secondary Motion is enabled, it will 
need to be completed before moving onto the selected next move.

1
These determine which events, if any, will terminate a move. Any combination, including all or none, of the termination types 
may be used. However, if current limit AND switch termination options are both used, both must be fulfilled before the motion 
segment terminates.

2

These determine whether to trigger faults on the listed events. The action taken from the fault is determined on the Faults tab 
of the System Setup page.
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8.4.2 Move Examples

Main Move and Secondary Move,  
Note: Ramp from Main to Secondary always uses the Acceleration ramp

Main Move and Secondary Move,  
Note: Ramp from Main to Secondary always uses the Acceleration ramp

Moves ended with a termination of switch or current limit

8.5 ANALOG MOTION PAGES
The Analog Input can be setup as a position command, a velocity command, or a current command. The Expert software provides 
a page for each, with the specific parameters needed for each type of analog motion control.

The Analog Input is calibrated at the factory; if there a need to change this calibration, see the Analog I/O section.

Secondary Move Velocity

Acceleration

8.4.1 Move Setup Parameters 

Move Select the Move (0-15) for defining the below parameters.

Enable Secondary Motion
An optional Secondary Motion can be used to perform a move after the Main Motion move 
is completed. The Secondary Motion has the same options as the Main Motion move.

Move Type Select the type of move here. The types are defined below.

Absolute Position Move to the desired position relative to home.

Incremental Distance

Move a specified distance each time the move is initiated. If Incremental move type is 
selected, do not use the Move Maintained Input Function because as soon as the move is 
complete, another one will immediately start. Move Momentary Input Function should be 
use for Incremental type moves.

Unlimited (+/-)
Move unlimited in the positive or negative direction until a limit is reached, there is a 
command to stop, pause or disable, or a termination condition is reached.

Absolute (+/- dir only)
Move to the desired position relative to home only if the position is more positive or more 
negative than the current position respectively.

Position/Distance Defines the move position or distance specified in user units.

Velocity Defines the velocity of the move in user units.

Acceleration Defines the acceleration of the move in user units.

Deceleration Defines the deceleration of the move in user units.

Limit Current Select the check box to limit current for a given move.

Terminate on current limit 1 Terminate the move when the current limit is reached.

Terminate on switch  
active / rising

1 Terminate the move when the Termination Switch switches to active / rising state.

Terminate on switch 
inactive / falling

1 Terminate the move when the Termination Switch switches to inactive / falling state.

Fault if not terminated by 
switch or current

2 Issue fault if not terminated by switch or current

Fault if terminated by switch 2 Only selectable when Terminated on switch is selected. Issue fault if terminated by switch.

Fault if terminated by current 
limit

Issue fault if terminated by current limit

Primary / Secondary 
Velocity Override

Allows for the defined move velocity to be overridden with an external analog input or 
Modbus value. (See Velocity Override Page for more information) (Not available with all 
firmware versions)

Current Limit Defines the current limit value for a given move.

Wait for In Position
Check this to wait for the In-Position Window (Setup Page) to be satisfied before Auto 
Starting Next Move (above).

Termination Switch Defines which switch to terminate the move on if a Terminate on Switch option is checked.

Auto-Start Next Move
Check this box to “string” moves together and select from the drop-down menu which move 
to proceed to after the current move is completed. If a Secondary Motion is enabled, it will 
need to be completed before moving onto the selected next move.

1
These determine which events, if any, will terminate a move. Any combination, including all or none, of the termination types 
may be used. However, if current limit AND switch termination options are both used, both must be fulfilled before the motion 
segment terminates.

2

These determine whether to trigger faults on the listed events. The action taken from the fault is determined on the Faults tab 
of the System Setup page.
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8.5.1 Analog Position Page

Analog Position control provides position control proportional to the Analog Input value. The input is continuously updated and 
scaled to provide an analog command position. If the Analog Position control is active from Default, Alternate or Host mode, the 
drive will move to the commanded position, while following the Velocity Limit and Acceleration Limit specified on the page. The 
Acceleration Limit is also used as the deceleration limit. 

Analog Input Channel
1 Select the type of analog signal to be used; options are- Analog Input Voltage, IA4 Op-
tion (4-20 mA)(if the IA4 Option board is installed) or Modbus Control.

Analog Command
This displays the commanded position, in user units, based on the Analog Input value 
and the scaling.

Maximum/Minimum Position
These should be set to the desired motor/actuator positions, in user units, when the 
Analog Input is at the maximum/minimum value respectively. (See Analog Input Scaling 
section).

Velocity Limit This is the maximum velocity during an Analog Position move.

Acceleration Limit This is the maximum acceleration/deceleration during an Analog Position move

Limit Current

If this checkbox is checked, the current for analog positioning will be limited to the value 
displayed below in the Current Limit parameters. For actuators with newer firmware there 
is now a separate current limit for travel in the negative direction. If the negative current 
limit is set to 0, the setting for the positive current limit is used in both directions.

Modbus Source

2 The position is controlled be the slider bar or a value sent to the Modbus register. This 
will apply the corresponding percentage of the minimum and maximum limits. Modbus 
Control must be selected in the Analog Input Channel menu.

1 The Modbus Control feature is available in Firmware version 2.27 and higher for the DC and 75 mm AC Tritex and version 2.20 
or higher for the 90/115 mm AC Tritex

2 Modbus Source control is not available on EXP 24, Tritex II AC with firmware revision older than 2.12 or Tritex II DC Tritex with 
firmware older than 2.27. Negative Current Limit is not available with firmware older than 3.00.
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8.5.2 Analog Velocity Page

Analog Velocity control provides velocity control proportional to the Analog Input value. The input is continuously updated and 
scaled to provide an analog command velocity. If the Analog Velocity control is active from Default, Alternate or Host modes, the 
drive will operate in velocity control, following the Acceleration Limit as specified on the page. The Acceleration Limit is also used 
as the deceleration limit. In Analog Velocity mode, position control is the responsibility of the user’s control system.

Analog Input Channel
1 Select the type of analog signal to be used; options are- Analog Input Voltage, IA4 
Option (4-20 mA)(if the IA4 Option board is installed) or Modbus Control.

Analog Command
This displays the commanded position, in user units, based on the Analog Input value 
and the scaling.

Maximum/Minimum Velocity
These should be set to the desired motor/actuator positions, in user units, when the 
Analog Input is at the maximum/minimum value respectively. (See Analog Input Scaling 
section).

Velocity Limit This is the maximum velocity during an Analog Velocity move.

Acceleration Limit This is the maximum acceleration/deceleration during an Analog Velocity move

Modbus Source

2 The velocity is controlled be the slider bar or a value sent to the Modbus register. This 
will apply the corresponding percentage of the minimum and maximum limits. Modbus 
Control must be selected in the Analog Input Channel menu.

1
The Modbus Control feature is available in Firmware version 2.27 and higher for the DC and 75 mm AC Tritex and version 
2.20 or higher for the 90/115 mm AC Tritex.

2 Modbus Source control is not available on EXP 24, Tritex II AC with firmware revision older than 2.12 or Tritex II DC with 
firmware older than 2.27. Negative Current Limit is not available with firmware older than 3.00.

8.5.1 Analog Position Page

Analog Position control provides position control proportional to the Analog Input value. The input is continuously updated and 
scaled to provide an analog command position. If the Analog Position control is active from Default, Alternate or Host mode, the 
drive will move to the commanded position, while following the Velocity Limit and Acceleration Limit specified on the page. The 
Acceleration Limit is also used as the deceleration limit. 

Analog Input Channel
1 Select the type of analog signal to be used; options are- Analog Input Voltage, IA4 Op-
tion (4-20 mA)(if the IA4 Option board is installed) or Modbus Control.

Analog Command
This displays the commanded position, in user units, based on the Analog Input value 
and the scaling.

Maximum/Minimum Position
These should be set to the desired motor/actuator positions, in user units, when the 
Analog Input is at the maximum/minimum value respectively. (See Analog Input Scaling 
section).

Velocity Limit This is the maximum velocity during an Analog Position move.

Acceleration Limit This is the maximum acceleration/deceleration during an Analog Position move

Limit Current

If this checkbox is checked, the current for analog positioning will be limited to the value 
displayed below in the Current Limit parameters. For actuators with newer firmware there 
is now a separate current limit for travel in the negative direction. If the negative current 
limit is set to 0, the setting for the positive current limit is used in both directions.

Modbus Source

2 The position is controlled be the slider bar or a value sent to the Modbus register. This 
will apply the corresponding percentage of the minimum and maximum limits. Modbus 
Control must be selected in the Analog Input Channel menu.

1 The Modbus Control feature is available in Firmware version 2.27 and higher for the DC and 75 mm AC Tritex and version 2.20 
or higher for the 90/115 mm AC Tritex

2 Modbus Source control is not available on EXP 24, Tritex II AC with firmware revision older than 2.12 or Tritex II DC Tritex with 
firmware older than 2.27. Negative Current Limit is not available with firmware older than 3.00.

Commissioning Software Tool
TRITEX® SERIESactuators



46 | Expert™ Software Manual for Tritex® Actuators Curtiss-Wright | Rev M | PN47703 | 10/07/2022

8.5.3 Analog Torque Page

Analog Torque control provides current control based on the Analog Input value. The input is continuously updated and scaled 
to provide an analog command torque. If the Analog Torque control is active from Default, Alternate or Host modes, the drive will 
operate in torque/force control. In Analog Current control, velocity and position control are the responsibility of the user’s control 
system.

Analog Input Channel
1 Select the type of analog signal to be used; options are- Analog Input Voltage, IA4 
Option (4-20 mA)(if the IA4 Option board is installed) or Modbus Control.

Analog Command
This displays the commanded position, in user units, based on the Analog Input value 
and the scaling.

Maximum/Minimum Current
This should be set to the desired motor/actuator currents, in Amps, when the Analog 
Input is at the maximum/minimum value, respectively. (See Analog Input Scaling 
section.)

Modbus Source

2 The torque is controlled be the slider bar or a value sent to the Modbus register. This 
will apply the corresponding percentage of the minimum and maximum limits. Modbus 
Control must be selected in the Analog Input Channel menu.

1 The Modbus Control feature is available in Firmware version 2.27 and higher for the DC and 75 mm AC Tritex and version 2.20 
or higher for the 90/115 mm AC Tritex.

2 Modbus Source control is not available on EXP 24, Tritex II AC with firmware revision older than 2.12 or Tritex II DC with 
firmware older than 2.27. Negative Current Limit is not available with firmware older than 3.00.
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8.6 VELOCITY OVERRIDE
Velocity Override provides a real-time method to change the Velocity of a Move. The Velocity Override will take effect immediately, 
even during a move. The Acceleration and Deceleration ramps of the active move will be honored even if the Override value 
changes instantaneously. 

Velocity Override control is not available on EXP 24, Tritex II AC with firmware revision older than 2.11 or Tritex II DC Tritex with firmware 
older than 2.27

When Primary or Secondary Velocity Override boxes are checked on the Move Setup page, this page determines the source and 
range of the Override value to be applied. 

Velocity Override Source
1 Select the type of analog signal to be used; options are- Analog Input Voltage, IA4 Op-
tion (4-20mA)(if the IA4 Option board is installed) or Modbus Control. 

Maximum/Minimum Override
This should be set to the desired percentage limits of the defined move velocity. The 
Modbus Source slider will also be limited by these values.

Modbus Source

This slider bar can be controlled with a mouse drag or a Modbus value being entered 
into the correct register. Modbus Control must be selected in the Analog Input Channel 
menu and the percentage limits are limited to the minimum and maximum values entered 
above.

1 The Velocity Override feature is available in Firmware version 2.27 and higher for the DC and 75 mm AC Tritex and version 
2.20 or higher for the 90/115 mm AC Tritex.

8.5.3 Analog Torque Page

Analog Torque control provides current control based on the Analog Input value. The input is continuously updated and scaled 
to provide an analog command torque. If the Analog Torque control is active from Default, Alternate or Host modes, the drive will 
operate in torque/force control. In Analog Current control, velocity and position control are the responsibility of the user’s control 
system.

Analog Input Channel
1 Select the type of analog signal to be used; options are- Analog Input Voltage, IA4 
Option (4-20 mA)(if the IA4 Option board is installed) or Modbus Control.

Analog Command
This displays the commanded position, in user units, based on the Analog Input value 
and the scaling.

Maximum/Minimum Current
This should be set to the desired motor/actuator currents, in Amps, when the Analog 
Input is at the maximum/minimum value, respectively. (See Analog Input Scaling 
section.)

Modbus Source

2 The torque is controlled be the slider bar or a value sent to the Modbus register. This 
will apply the corresponding percentage of the minimum and maximum limits. Modbus 
Control must be selected in the Analog Input Channel menu.

1 The Modbus Control feature is available in Firmware version 2.27 and higher for the DC and 75 mm AC Tritex and version 2.20 
or higher for the 90/115 mm AC Tritex.

2 Modbus Source control is not available on EXP 24, Tritex II AC with firmware revision older than 2.12 or Tritex II DC with 
firmware older than 2.27. Negative Current Limit is not available with firmware older than 3.00.
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9. DIGITAL I/O
9.1 DIGITAL I/O PAGE
The Digital I/O screen is used to assign hardware digital input lines to logical input functions and logical output functions to 
hardware digital output lines and LED’s. Not all models have LED’s that can be assigned to output functions and the number of 
digital inputs and digital outputs varies by model and options. See the Installation Manual for the appropriate model for hardware 
details. The Digital I/O page shows the correct number of I/O for the attached drive. Clicking on the Edit button opens the Input 
Functions and Output Functions trees. From the drop-down menus, select the input or output you would like to set. Next, select the 
action to be performed (for inputs only) when the bit is set, or select what action will cause a bit to be set (outputs and LED’s only). 
A download must be performed for the I/O assignments to take effect. 

9.1.1 Input/Output Polarity Assignments

Clicking the Polarity button will show polarity switches (“P” or “N”). Each input or output line can be assigned a positive “P” or 
negative “N” polarity. Clicking on the polarity buttons will toggle the polarity. An ‘N’ on an input means the selected function will be 
active when the input is off and inactive when the input is on. An ‘N’ on an output line means the output will be off when the function 
is active and on when the function is inactive. Note: This does not change the electrical characteristics of the I/O line.
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9.1.2 Input/Output Assignments

Click on the Edit button to show the Input / Output selection screens.

Select the Input/Output from the drop box.

Select the desired function from the Functions tree. A description of the function will appear for the action that will be taken. Click 
the Apply button to assign the function to the selected Input/Output.
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9.1.3 Virtual I/O Assignments

The Virtual I/O Assignments section allows an output event to set or clear and input event. By selecting either Virtual Output 1 or 2 
from the Output Assignments tab, a given output event can be selected. Likewise, by selecting either Virtual Input 1 or 2, from the 
Input Assignments tab, a given input event can be selected. Feature added with Tritex II AC 90/115 mm v2.21 and Tritex II DC and 
AC 75 mm v2.37. Not available on EXP-24.
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9.2 MONITOR PAGE
Found in the Monitor/Control section of the System Panel tree.

This screen shows actuator status along with position / velocity / current information. The digital input/output line statuses may also 
be viewed along with the board and actuator temperatures.

Output lines can be set (forced active) and overridden (forced inactive) on the Diagnostics Tab to test digital output hardware.

9.3 ADVANCED I/O ASSIGNMENT OPTIONS 
To view addional (advanced) I/O assignment parameters, from main menu bars select Options/User Options then click the User 
Interface tab, under the Parameter Display Priority box select 3-All parameters and all of the Input and Output fucntions will be 
available. 
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10. ANALOG I/O
This section covers the Analog I/O for the following Tritex products; T2X, TDX, TTX, R2M/G, RDM/G. (See the specific 
actuator Installation manual for detailed specifications). 

10.1 ANALOG VOLTAGE INPUT
The Analog input has a maximum range of +10 to -10 Volts and can be mapped as the command source for Analog 
Position, Analog Velocity, or Analog Torque motion modes or as a Velocity Override value for Move Velocities. The IA4 
option replaces the analog voltage I/O with analog 4-20 mA I/O. 

Enable Analog Input
This was a user option prior to firmware version 2.02. In all releases version 2.02 and later 
it is automatically enabled, and the option bit is ignored. The checkbox should not show up 
unless the software connects to an actuator with firmware version 2.01 or earlier.

Mode

Only displayed for T2X090, T2X115, R2M/G090, R2M/G115  actuators. This selection must 
be set to 0-10 Volt Range or -10 to +10 Volt Range to match the range of the analog signal 
that will be used. For other actuators this selection is not needed because the hardware 
always handles the full -10 to +10 V range.

Bandwidth

Is the break frequency in Hertz of a digital low-pass filter on the Analog Input. The value is 
essentially the maximum frequency the filter will allow. This filter is used to eliminate higher 
frequency interference on the analog signal. Typical values for Analog Position Mode are 
1-5 Hz, for Analog Velocity or Torque Mode they can be set higher if needed for stability by 
the host control loop. Do not enter 0, though it is allowed in present firmware and software, 
because this will freeze the input.

Minimum and Maximum
Values are set to the desired range of the actual Analog Input Voltage. These minimum and 
maximum Voltages will be scaled to correspond with the minimum and maximum command 
values on the Analog Position, Analog Velocity Analog Torque and Velocity Override pages.

Set to Input Value Buttons

These buttons can only be used when actively Online with the actuator. The purpose of 
these buttons is to provide an easy method of matching the min and max analog value 
from a host controller to the exact Minimum and Maximum Voltages used by the Tritex. For 
example: If there is a slight discrepancy between the value displayed in the Tritex Software 
and the host control of the 0 V and/or 10 V values, set the host controller to apply 0 V and 
click the Minimum Set to Input Value button, the set the host controller to apply 10 V and 
then click the Maximum Set to Input Value button. The Actual Voltages, as measured by 
Tritex, will show in Minimum and Maximum windows. A download must be performed to 
permanently save the values.

Low and High Trip
Low and High Trip Voltage limits can be set, if the enable check box is selected and the 
Analog Input Voltage is outside of the range, a Loss of Signal Fault condition will occur. The 
action taken when the fault occurs is set on the Fault Enables tab of the System Setup page
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10.2 ANALOG INPUT CALIBRATION
The analog input circuit is factory calibrated and does not typically need periodic calibration. The purpose of calibration is to 
represent accurately the voltage applied at the channel as a digital value. Converting that value to a position value for instance 
is called scaling and is done elsewhere. Calibration should only be done if a calibration check by applying known voltages and 
comparing them with the values appearing in the “Volts” monitor box on the Input Setup tab of the Analog I/O page indicate 
calibration is required.

To access the Input Calibration page, click on the red Calibrate button on the Analog I/O page, Input Setup tab. If such a button 
is not visible, right click in the area just outside of the border of the Input Setup tab. Then click on the Show Page Details line in 
the menu that pops up. The Calibrate button will then appear. The Tritex TTX, TDX, RDM/G and T2X075, input calibration page is 
shown below. The process for Tritex T2X090/115 and R2M/G090/115 is similar but does not have the Calibrate Zero button. Follow 
the instructions below, or on the screen and click the Save Calibration points button when complete.

Make sure the actuator is “ON-LINE” and communicating with Expert software. Then make sure the actuator is disabled or 
otherwise not commanding motion based on the analog input.

For a Tritex T2X090/115 and R2M/G090/115:

Apply a voltage between +9 V and +10 V from Analog In + to Analog In – terminals. Measure this voltage with a DVM. Enter 
the actual voltage in the High box and with the voltage still applied click on the Calibrate High button. 
Then if the actuator is in 0 V to +10 V mode as determined in checkbox on Input Setup tab, apply a voltage of about + 0.2 V 
from Analog In + to Analog In – terminals, enter the voltage from the DVM in the Low box and with the voltage still applied, 
click on the Calibrate Low button.

Or if the actuator is in -10 V to +10 V mode as determined in checkbox on Input Setup tab, apply a voltage of between -9 V to 
-10 V from Analog In + to Analog In – terminals, enter the voltage from the DVM in the Low box including the negative sign, 
and click on the Calibrate Low button.

For a Tritex TTX, TDX, RDM/G and T2X075:

Apply a voltage between +9 V and +10 V from Analog In + to Analog In – terminals. Measure this voltage with a DVM. Enter 
the actual voltage in the High box and with the voltage still applied click on the Calibrate High button. 
Then remove the voltage and directly short the Analog In + to Analog In – terminals for a known 0 V signal. Click on the 
Calibrate Zero button.

Then remove the short and apply a voltage between -9 V and -10 V from Analog In + to Analog In – terminals, enter the 
voltage from the DVM in the Low box including the negative sign, and with the voltage still applied click on the Calibrate Low 
button.

Then click on the Save calibration points button. Apply voltages to confirm that the calibration was successful.

Commissioning Software Tool
TRITEX® SERIESactuators



54 | Expert™ Software Manual for Tritex® Actuators Curtiss-Wright | Rev M | PN47703 | 10/07/2022

10.3 ANALOG OUTPUT 
The Voltage Analog output has a maximum range of 0 to +10 V and can be mapped to any of several actuator variables such 
as Position, Current, Temperature, etc. The Voltage Analog Output is replaced by the 4-20 mA analog output on Tritex Tritex 
TTX, TDX, RDM/G and T2X075 actuators, so is not available on those models. It is available on all Tritex T2X090/115 and RDM/
G090/115 models.
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Enable DAC Output This box should always be checked. It may not appear on all pages.

Bandwidth

Is the break frequency in Hz of a digital low-pass filter on the Analog Output. This filter is 
used to smooth out sharp steps, spikes or dithering on the measured signal on the way 
to the output signal. The lower the number the more damping is applied. Do not enter 0, 
though it may be allowed in present firmware and software, because this will freeze the 
output.

Output Variable Select from the drop-down menu a drive variable to be mapped to the Analog Output.

Output Units
To scale the output correctly using Var Min and Var Max values, Output Units must be set 
to correspond to the Output Variable selected. For example if Feedback Position is the 
Output Variable choose Distance as the Output Units.

Var Min, Var Max
These are the minimum and maximum values of the selected variable in units selected. 
The Var Min value will produce 0 V on the Analog Output and the Var Max value will 
produce 10.0 V on the Analog Output.

% and Volts Display

These displays are only active while online. The % display will show the % value of the 
selected variable over range of Var Min to Var Max. In the above example the Output 
Variable is Feedback Position and the Range is 0.000 to 5.000 in, the actual Feedback 
Position is 2.500 in, so 50% is the displayed value. The Volts display is an approximation 
that does not include the effects of calibration, so is for reference only. It is not the actual 
output signal.

10.4 ANALOG OUTPUT CALIBRATION
The Analog Output has been calibrated at the factory so 0-100% covers a span of 0 V to +10.0 V. Re-calibration of the analog 
output is not recommended. 
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10.5 IA4 OPTION BOARD
This section covers the 4-20 mA Analog I/O. (See the specific actuator Installation manual for detailed specifications). These 4-20 
mA I/O are only available on actuators with the IA4 option.

10.5.1 4-20 mA Input

The input can be mapped as the command source for Analog Position, Analog Velocity, or Analog Torque motion modes or as a 
Velocity Override value for Move Velocities. 

Enable Analog Input
This was a user option prior to firmware version 2.02. In all releases version 2.02 and later it is 
automatically enabled, and the option bit is ignored. The checkbox should not show up unless the 
software connects to an actuator with firmware version 2.01 or earlier.

Bandwidth

Is the break frequency in Hertz of a digital low-pass filter on the Analog Input. The value is 
essentially the maximum frequency the filter will allow. This filter is used to eliminate higher 
frequency interference on the analog signal. Typical values for Analog Position Mode are 1-5 Hz, 
for Analog Velocity or Torque Mode they can be set higher if needed for stability by the host control 
loop. Do not enter 0, though it is allowed in present firmware and software, because this will freeze 
the input.

Minimum and Maximum

These values assign input signal values to the desired 0-100% of range of the 4-20 mA Input. 
Typically 4 mA is assigned as the 0% value and 20 mA is assigned as the 100% value. The 0 
and 100% percent of range values will be scaled to correspond with the minimum and maximum 
command values on the Analog Position, Analog Velocity Analog Torque and Velocity Override 
pages. For Valve applications, these values are renamed Closed and Open, respectively.

Set to Input Value Buttons

These buttons can be used only when actively online with the actuator. The purpose of these 
buttons is to provide an easy method of matching the min and max 4-20 mA value from a host 
controller to the exact Minimum and Maximum values used by the Tritex. For example, if there is a 
slight discrepancy between the value displayed by the Tritex Software and the host control for the 
4 mA and/or 20 mA values, set the host controller to apply 4 mA and click the Minimum Set to Input 
Value button, then set the host controller to apply 20 mA and click the Maximum Set to Input Value 
button. The Actual mA values, as measured by Tritex, will show in Minimum and Maximum windows. 
A download must be performed to permanently save the values.

Low and High Trip

Low and High Trip mA limits can be set, if the enable check box is selected and the 4-20 mA input 
is outside of the range a Loss of Signal Fault condition will occur. The action taken when the fault 
occurs is dependent on the setting on the Fault Enables tab of the System Setup page. In the 
example above, if the input drops below 3.5mA, a fault condition will occur.
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10.5.2 4-20 mA Input Calibration

The analog input circuit is factory calibrated and does not typically need periodic calibration. The purpose of calibration is to 
represent accurately the current applied at the channel as a digital value. Converting that value to a position value for instance 
is called scaling and is done elsewhere. Calibration should only be done if a calibration check by applying known currents and 
comparing them with the values appearing in the “mA” monitor box on the Input Setup tab of the IA4 Option Board page indicate 
calibration is required.

To access the calibration page, click on the red Calibrate button on the IA4 Option Board page, Input Setup tab. If such a button 
is not visible, right click in the area just outside of the border of the Input Setup tab. Then click on the Show Page Details line in 
the menu that pops up. The Calibrate button will then appear. The IA4 Option Configuration page is shown below. The process for 
Tritex T2X090/115 and R2M/G090/115 is similar but does not have the Calibrate Zero button. Follow the instructions below, or on 
the screen and click the Save Calibration points button when complete. 

A Loop Calibrator instrument that provides loop power and an accurate current is very useful for calibrating a 4-20 mA input. The 
input is best calibrated at 4 mA and 20 mA. 
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10.5.3 4-20 mA Output

The Tritex actuator with –IA4 option has one physical analog 4-20 mA output, but there are two independent setups for the output 
that can be switched dynamically onto the output channel. Each setup can be mapped from any of several internal parameters 
and scaled to produce the desired output over a specified range. The variable in Output Setup 1 is applied to the 4-20 mA output 
channel unless input function Switch Analog Output is active when the variable in Output Setup 2 is applied.

Output 1, Output 2 tabs
Each of the two setups has a tab to configure and scale a variable to be applied to the 4-20 mA 
output channel. The Active LED box indicates which channel is currently applied to the 4-20 mA 
output channel.

Enable DAC Output
This was a user option prior to firmware version 2.02. In all releases version 2.02 and later it is 
automatically enabled, and the option bit is ignored. The checkbox should not show up unless 
the software connects to an actuator with firmware version 2.01 or earlier.

Bandwidth

Is the break frequency in Hz of a digital low-pass filter on the Analog Output. This filter is used 
to smooth out sharp steps, spikes or dithering on the measured signal on the way to the output 
signal. The lower the number the more damping is applied. Do not enter 0, though it may be 
allowed in present firmware and software, because this will freeze the output.

Output Variable Select from the drop-down menu the variable to be assigned to the Analog Output.

Output Units
To scale the output correctly using Var Min and Var Max values, Output Units must be set to 
correspond to the Output Variable selected. For example if Feedback Position is the Output 
Variable choose Distance as the Output Units.

Var Min, Var Max
These are the minimum and maximum values of the selected variable in units selected. The 
Var Min value will produce 4mA on the Analog Output and the Var Max value will produce 20 
mA on the Analog Output.

% and mA Display

These displays are only active while online. The % display will show the % value of the se-
lected variable over range of Var Min to Var Max. In the above example the Output Variable is 
Feedback Position, the Range is 0.000 to 5.000 in, and the actual Feedback Position is 2.500 
in. Therefore 50% is the displayed value. The mA display is an approximation that does not 
include the effects of calibration, so is for reference only. It is not the actual mA output.
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10.5.4 4-20 mA Output Calibration

The 4-20 mA Output has been calibrated at the factory so 0-100% covers a span of 4 mA to 20 mA. Typically calibration is not 
required unless a different range is desired or if re-calibration is required to match the 4-20 mA Output to a measurement device, 
such as another controller’s analog input or an ammeter.

To access the Output Calibration page, right click in the area just outside of the Output Setup tab and then select (left click) the 
Show Page Details line in the menu. Then click on the Calibrate button that appears near the 4-20 mA bar.

The actual hardware output is designed to allow an output span that is greater than 4mA to 20 mA, this assures that 4-20 mA can 
always be delivered to the Host considering all component tolerances and other losses before the signal gets to the host controller.

Make sure all configuration changes are saved to the actuator and save the drive file before calibrating.

To calibrate the 4-20 mA analog output:
1) Connect a Loop Calibrator or loop power supply and DVM in mA mode to the Analog Output terminals of the actuator. Meter 

must be able to read to at least 20 mA with 2 uA resolution.
2) With the actuator disabled, record the correct values of the following parameters on the Output Setup that is Active and then 

temporarily reconfigure them to these values: 
  Output Variable = Positional Following Error 
  Output Units = Distance 
  Var Max = 0 
  Var Min = -1000 
This will create an output target of 100.00%

3) Enter 3.30 for a Tritex T2X090/115 and R2M/G090/115  or 6.5 for a Tritex II DC or AC 75 mm actuator in the High End Offset 
entry box as a starting point. Measure the current on the output which should be close to 20 mA.

4) Iteratively enter slightly higher or lower values into High End Offset until the current measures 20.000+/-.002 mA.
5) Temporarily change the following values in the Output Setup that is Active: 

  Var Max = 1000 
  Var Min = 0 
This will create an output target of 0.00%

6) Enter 19.30 for a Tritex T2X090/115 and R2M/G090/115 or 6.5 for a Tritex II DC or AC 75 mm actuator in the Low End Offset 
entry box as a starting point. Measure the current on the output which should be close to 4 mA.

7) Iteratively enter slightly higher or lower values into High End Offset until the current measures 4.000+/-.002 mA.
8) Restore the Output Setup page to its original setting, making sure the values are sent to the drive by right clicking on the box 

and selecting (left clicking) the Write current value to connected drive entry.
9) Click on the Save Calibration Values button to store the new values to NVM.
10) Check operation of the output to make sure it is correctly calibrated and then disconnect the loop power supply and meter.

Hardware mA Output
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The newly calibrated numbers are not saved in the drive’s non-volatile memory until the Save calibration points button is pressed.

11. COMPARATORS

This feature is available in Firmware version 2.37 and higher for the Tritex TTX, TDX, RDM/G and T2X075 and version 2.20 or higher for 
the T2X090/115 and R2M/G090/115.

Two comparators allow output events to be set based on the state of the comparator outputs. The Comparator output events are 
Comparator 1 and Comparator 2.

Comparator Variable

Selected the desired Comparator Variable from the drop-down list of possible variables. 
Appropriate Units must be selected. The state of the Comparator Output is determined 
by the variable’s value with respected to the selected Operator, Setpoint, and Hysteresis 
values.

Operator The three possible operators are:

+ Output will be active if Variable is within the range Setpoint +/- Hysteresis.

>
Output will be active if Variable is greater than Setpoint. The Output will go inactive once 
the value drops below the value Setpoint – Hysteresis

<
Output will be active if Variable is less than Setpoint. The Output will go inactive once the 
value goes above the value Setpoint + Hysteresis.

Setpoint
The value that is compared to the present value of the Comparator Variable to determine 
the state of the comparator output. Both values will have the same units.

Hysteresis

For > or < operators, this is a true hysteresis, modifying the effective setpoint by the 
hysteresis in order to turn the output from active to inactive. This value is designed to 
prevent the output from repeatedly changing state due to normal fluctuation or dither on 
the comparator variable. For the +- operator, the hysteresis value sets a range on either 
side of the setpoint and the output will be active if within this range.

User Units
It is important that the correct Units are selected for the comparator variable for the 
Setpoint and Hysteresis values to be interpreted correctly.

Active indicator
When the Output is Active, the Active LED on the screen will turn on and the output event 
shown on the Digital I/O screen will be active. The Output function can be used externally 
or assigned through virtual I/O to an input function.
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12. ADVANCED CONTROLS
12.1 ONLINE STATUS AND CONTROL
The Status, Monitor and Diagnostics pages are very useful for observing drive operation. For more information on the Status see 
the Online Diagnostic section towards the end of this manual

12.2 CONTROL PAGE
The Control page can be used for starting and stopping motion directly from the screen.
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12.3 STATUS CONTROL
Operating state, key conditions, faults, and warnings can be viewed most easily on the Status page. This page is normally part of 
all applications and is docked at the bottom of the screen. This page can be found under the Monitor/Control section of the page 
tree.

The action taken by certain fault conditions is selectable by the user. (See the System Setup section for details on user selection of 
faults and warnings).

Referring to the image above, Disabled is the current operating state of the actuator.

Faults & Warnings are also displayed on the Status page. A Following Error is displayed as the current fault condition for the 
example above. If the fault condition no longer exists, clicking the Reset Fault button will clear this fault. If the condition still exists, 
the drive will fault again.

Position, velocity, and motor current are displayed on this page as well.
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12.4 INPUT FUNCTION CONTROL / OUTPUT FUNCTION STATUS
The Input Function Control allows the user to monitor and control all input functions. When enabled the control appears on the 
right-hand side of the screen. It can also be used in conjunction with the Output Function Status.

The Output Function Status indicates the status of all the output functions. Both the Input Function Control and Output Function 
Status pages can be opened by going to the menu bar and clicking View/Page and select the desired page, or from the System 
Panel, if that is visible.
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12.4.1 Input Function Definitions

Enable Momentary
The drive will try to enable on the rising edge. If a fault prevents the enable from occurring, another 
rising edge is required. On start-up or power cycle, a rising edge of the Enable Momentary is required to 
re-enable.

Enable Maintained

The drive will enable if bus power is applied and there are no active faults. If there is a fault, toggling the 
Enable Maintained function will clear the fault. If the fault condition still exists, the drive with fault again. 
On start-up or power cycle with no active faults, the drive will automatically re-enable after the Power-up 
Delay expires.

Stop
Activating the Stop function will stop all motion using the defined Stop Ramp deceleration value. When 
the Stop function is removed, motion is allowed to resume. The Stop function is available in all modes of 
operation.

Pause

When not in Host mode, all motion except a Jog will decelerate to a stop using the ramp of the active 
motion. When the Pause function is removed the motion will continue using acceleration ramp of the 
active motion. The Pause input function does NOT pause Jog motion and does not affect motion while 
in Host mode.

Jog (+ / -)

Activates the Jog motion, (see Jog page section). Jog can be selected to have a higher priority and, 
therefore, override other motion types. (See the Options tab of the System Setup page). Only one 
direction of Jog is allowed to be active at time. If both Jog directions are selected at once, the operating 
status will report that it is trying to Jog, but it will not move either direction.

Jog Fast
When active selects the Fast velocity defined on the Jog page when jogging. Otherwise the Slow 
velocity will be used.

Alternate Mode

A Tritex Actuator has several operating modes. The Alternate Mode input function when active sets 
the actuator into the operating mode defined on the System Setup page Operating Modes tab in the 
Alternate Select Box If the Alternate Mode function goes inactive, the actuator goes into the operating 
mode defined by the Default Select Box. Default and Alternate mode selections may be one of the 
following: Inactive, Digital Inputs, Analog Position, Analog Velocity, or Analog Torque. For example: 
Default mode set to Digital Inputs and Alternate mode set to Analog Position. When the Alternate mode 
is disabled, the Digital Inputs could be used to control the Home move, Jog and Moves, as required. 
When the Alternate Mode input function is active, the position is controlled from the Analog Input. There 
are Host operating modes that can take precedence over this mode selection.

Home
Initiates a Home move. (See the Home page section for Home parameters setup). The Home move will 
start on the edge of the Home input Function. The function does not need to remain active to complete 
the Home move sequence

Dedicated Position

Activates the Dedicated Move function (See Dedicate Move section for parameters & operation). This 
is a maintained type input function; if the input is turned off the dedicated move will stop and, if other 
motion is being commanded, it will resume. Dedicated Move has high priority and will override all motion 
types except motion commanded from Host mode. Dedicated Move is only available if the Homed 
output function is set, after a Home move has completed or the Define Home input function goes active.

Define Home

Defines the current position as the Final Home Position parameter and sets the Homed output function. 
This function is always available, so should be used with caution. When activated, even during motion, 
a new Home position will be defined. If a Maintained Move is being executed or Analog Position mode 
or Host Position mode is active, the motor/actuator will move to the commanded position relative to the 
new Home position.

Teach Enable Enables the Teach function.

Reset Faults
1 The rising edge of this input function resets all fault flags if the fault condition is not currently active. If 
there is an active fault condition, the active fault flag will not be reset.

1

Toggling the Enable input function performs this same action.
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Teach Select Performs a Teach function.

Brake Override
Overrides Tritex actuator control of an internal brake when so equipped. When active, the 
brake will release when the drive is not enabled.

Move Maintained Select

Input functions Select 3, Select 2, Select 1, and Select 0 form a binary number in that bit order 
to select Move 0 to Move 15. Move Maintained Select activates the move determined by the 
binary number as a maintained move. See Move x (Maintained) input function description 
below. Changing the binary number during the move will switch to the move defined by the 
new binary number immediately. Move Maintained Select has precedence over a Move x 
(Maintained) move, or any Move Momentary.

Move Momentary Select

Input functions Select 3, Select 2, Select 1, and Select 0 form a binary number in that bit order 
to select Move 0 to Move 15. Move Momentary Select activates the move determined by the 
binary number as a maintained move. See Move x (Momentary) input function description 
below. Changing the binary number or toggling Move Momentary Select or toggling a Move x 
(momentary) during the move will have no effect until the move completes.

Move x (maintained)

1 The Move x Maintained input functions with x = 0 to 15 are designed to be used with 
absolute move types. Once activated, the specified move will be executed. If the function is 
deactivated during the move, motion will decelerate to a stop and resume when the function is 
re-activated. If more than one Move Maintained move is active, the lowest number move has 
priority. Move Maintained has priority over Move Momentary.

Move x (momentary)

The Move x Momentary input functions with x = 0 to 15 can be used with any move type. 
The rising edge of the input function will start the specified move if no other move is currently 
active. If the input function is left “on”, a subsequent move will start on the next rising edge 
after the previous move is completed. Turning the input function “off” during a move will not 
affect the motion.

Move x (teach)

The rising edge of a Move x (teach) input function with x = 0 to 15 loads the current position 
into the respective Move x positions. They work only when the Teach Enable input function 
is active. Teach Enable can be activated from a digital input or automatically by selecting the 
Always Enable Teach input functions check box (see System Setup page section). These 
positions are automatically saved into non-volatile memory.

Select x

The Select x input functions with x = 0 to 3 are used with Move Maintained Select and Move 
Momentary Select input functions to select any of the 16 Moves using fewer Digital Inputs. 
Select 3, Select 2, Select 1, and Select 0 form a binary number in that bit order to select 
Move 0 to Move 15. Assign Select x input functions to up to four of digital inputs. For instance 
turning on the inputs assigned to Select 3 and Select 0 and turning off the inputs assigned to 
Select 1 and Select 2, will select Move 9. If another input is then assigned to Move Maintained 
Select or Move Momentary Select and turned “on”, it will execute Move 9 accordingly. , 
Unused Select x input functions may be left unassigned and the values will remain “off” or 0. 
For instance, if only Move 0 to Move 7 are used, Select 3 need not be assigned to a digital 
input.

Switch 1 - 8 Maintained 
Switch 9 - 16 Momentary

These input functions are designed to terminate the feed portion of a move. If a move is set 
to terminate on a switch being active or inactive, and one or more of Switch 1-8 has been 
assigned to a Digital Input, the Move will terminate at any point when it sees the appropriate 
active or inactive condition. However, if Switch 9-16 are assigned, the Move will only terminate 
when an edge is seen, i.e., a switch being set active or inactive.

Switch Analog Output
When active applies the alternate analog signal to the analog output channel. Available on 
4-20 mA Output only.

Calibrate Stroke When this input function goes active, the Stroke Calibration sequence launches.

1 If the Move Maintained input function is used with Incremental move types, all subsequent incremental moves will be started 
immediately after each one is completed. Therefore, for Incremental moves, Exlar suggests using the Move x (Momentary) 
input functions.

12.4.1 Input Function Definitions

Enable Momentary
The drive will try to enable on the rising edge. If a fault prevents the enable from occurring, another 
rising edge is required. On start-up or power cycle, a rising edge of the Enable Momentary is required to 
re-enable.

Enable Maintained

The drive will enable if bus power is applied and there are no active faults. If there is a fault, toggling the 
Enable Maintained function will clear the fault. If the fault condition still exists, the drive with fault again. 
On start-up or power cycle with no active faults, the drive will automatically re-enable after the Power-up 
Delay expires.

Stop
Activating the Stop function will stop all motion using the defined Stop Ramp deceleration value. When 
the Stop function is removed, motion is allowed to resume. The Stop function is available in all modes of 
operation.

Pause

When not in Host mode, all motion except a Jog will decelerate to a stop using the ramp of the active 
motion. When the Pause function is removed the motion will continue using acceleration ramp of the 
active motion. The Pause input function does NOT pause Jog motion and does not affect motion while 
in Host mode.

Jog (+ / -)

Activates the Jog motion, (see Jog page section). Jog can be selected to have a higher priority and, 
therefore, override other motion types. (See the Options tab of the System Setup page). Only one 
direction of Jog is allowed to be active at time. If both Jog directions are selected at once, the operating 
status will report that it is trying to Jog, but it will not move either direction.

Jog Fast
When active selects the Fast velocity defined on the Jog page when jogging. Otherwise the Slow 
velocity will be used.

Alternate Mode

A Tritex Actuator has several operating modes. The Alternate Mode input function when active sets 
the actuator into the operating mode defined on the System Setup page Operating Modes tab in the 
Alternate Select Box If the Alternate Mode function goes inactive, the actuator goes into the operating 
mode defined by the Default Select Box. Default and Alternate mode selections may be one of the 
following: Inactive, Digital Inputs, Analog Position, Analog Velocity, or Analog Torque. For example: 
Default mode set to Digital Inputs and Alternate mode set to Analog Position. When the Alternate mode 
is disabled, the Digital Inputs could be used to control the Home move, Jog and Moves, as required. 
When the Alternate Mode input function is active, the position is controlled from the Analog Input. There 
are Host operating modes that can take precedence over this mode selection.

Home
Initiates a Home move. (See the Home page section for Home parameters setup). The Home move will 
start on the edge of the Home input Function. The function does not need to remain active to complete 
the Home move sequence

Dedicated Position

Activates the Dedicated Move function (See Dedicate Move section for parameters & operation). This 
is a maintained type input function; if the input is turned off the dedicated move will stop and, if other 
motion is being commanded, it will resume. Dedicated Move has high priority and will override all motion 
types except motion commanded from Host mode. Dedicated Move is only available if the Homed 
output function is set, after a Home move has completed or the Define Home input function goes active.

Define Home

Defines the current position as the Final Home Position parameter and sets the Homed output function. 
This function is always available, so should be used with caution. When activated, even during motion, 
a new Home position will be defined. If a Maintained Move is being executed or Analog Position mode 
or Host Position mode is active, the motor/actuator will move to the commanded position relative to the 
new Home position.

Teach Enable Enables the Teach function.

Reset Faults
1 The rising edge of this input function resets all fault flags if the fault condition is not currently active. If 
there is an active fault condition, the active fault flag will not be reset.

1

Toggling the Enable input function performs this same action.
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12.4.2 Output Function Definitions

Enabled
Indicates the power stage of the drive is active. Requires that no faults are active, bus 
voltage is present and an Enable input function is active or Auto-enable on start-up is 
selected.

Homed

Indicates that a Home move has been completed or the Define Home input function had 
a rising edge so that absolute position is established. Homed goes inactive if a Home 
move is initiated, a Position Tracking Fault occurs or logic power is cycled. If the unit has 
the absolute feedback option, Homed will be set on power-up if the absolute feedback 
system has preserved absolute position.

Ready Indicates the drive is Enabled and Homed.

Faulted
Indicates the drive is in a fault condition. The active fault is displayed in the Status 
window. The user has control over some fault conditions. (See System Setup page).

Warning
Indicates a Warning condition. The active Warning is displayed in the Status window. The 
user may select which conditions indicate a warning. (See System Setup page section).

Fault or Warning This is the logical “OR” of the Faulted and Warning output functions.

Stop Indicates motion has been inhibited by an active Stop input function or fault action.

Pause Indicates motion is suspended by an active Pause input function.

Jog (+ / -) Indicates when Jog + or Jog - is active.

Default Mode Active Indicates when an actuator is in Default mode and Enabled.

Alternate Mode Active Indicates when an actuator is in Alternate mode and Enabled.

Homing Indicates when a Home move is active.

Dedicated Move Indicates when the Dedicated Move function is active.

Move Active
Indicates when any of the Moves (0-15) or Main Motion or Secondary Motion are active. 
This will also remain active if the Move Maintained input function is active, even if the 
specified Move is complete.

Secondary Active
Indicates when any of the Moves (0-15) Secondary Motion are active. This will also 
remain active if the Move Maintained input function is active, even if the specified Move 
is complete.

In Position
Indicates a target position has been reached within the window and for the necessary 
time defined by the In Position Window parameters.

At Home Position
Indicates when the actual position is within the window, defined by the In Position 
Window parameters, of the defined Final Home Position.

At Dedicated Position
Indicates when the actual position is within the window, defined by the In Position 
Window parameters, of the defined Dedicated Position.

At Home 2 Position
1 Indicates when the actual position is within the window, defined by the In Position 
Window parameters, of the defined Final Home 2 Position.

Shunt Active

Indicates when the shunt control circuit is active. It occurs when regeneration energy 
from deceleration or lowering a vertical load has raised the bus voltage above the shunt 
turn-on threshold. For the Tritex II DC actuators, it means that energy is being sent to a 
small internal shunt resistor. For Tritex II AC actuators, it means voltage is applied at the 
shunt resistor terminals.

Brake Release
Indicates when the brake is released, and the motor/actuator is free to move. This logic is 
active even if the unit has no brake and could be used to control an external brake.

1 The standard Expert software does NOT have an “on screen” parameter for setting a Final Home 2 Position, however, this can 
be set using Modbus protocols. (See Tritex II Parameters manual for more information on additional parameters that can be 
accessed by Modbus commands.)

Commissioning Software Tool
TRITEX® SERIESactuators



Expert™ Software Manual for Tritex® Actuators | 67www.exlar.com | 952.500.6200

Over Rated Current

Active when operating at more than the Continuous Current setting for the actuator. If it 
operates in this state too long, a Contiuous Current fault will occur, but the time to fault 
is shorter if the current is higher so is hard to predict and can vary from a few seconds to 
several minutes.

In Voltage Limit
Active when the drive needs more voltage than is available from the DC Bus, basically 
meaning it can’t go the speed being requested and will build following error.

In Current Limit

Active when any current limit is active. There is a Factory Current Limit (set at the factory 
by actuator model) that is always in force. At no time will commanded current exceed this 
value, chosen to prevent damage to the actuator. The User Current Limit (set by the user 
in the System Setup page) has second highest priority, allowing the user to set a limit lower 
than the Factory Current Limit to prevent damage to linkage and loads. However, some 
limits are move/motion specific. For example. during a Home move, the Home Current 
Limit is active and during the feed portion of a Move the feed Current Limit is active. This is 
not a fault condition, only an indication that the controller is limiting the current to the motor/
actuator. This condition will clear when the demand for the current is lowered.

In Current Limit (+ / -) Same as In Current Limit output function but active for only one direction.

Position Limit
Indicates the commanded position is outside of the position limit range. (See Position 
Limits tab in the System Setup page section.)

Position Limit (+ / -)
Active when the commanded position is outside of the position limit range in the positive or 
negative limit, respectively. 

Host Mode Active Indicates when Host Mode is active.

Seating Current Limit Active when the Seating Current Limit is active.

Stroke Calibration Active Active during the stroke calibration process.

Stroke Calibration Complete
Active after the stroke calibration process. Resets on power-up if stroke calibration is 
needed again.

Brake Delay Active
Indicates that the brake release or engage delay is active. These delays allow time for the 
brake to apply or release with a slight overlap between motor holding and brake holding to 
prevent droop.

PWM Bridge Active Indicates that the PWM bridge power is active. Generally use Enabled instead.

Move Active
1 Indicates when ANY of the Moves (0-15) are active. This will also remain active if the 
Move Maintained input function is active, even if the specified Move is complete.

Move 0-15 Active Indicates when the SPECIFIC Move (0-15) is active.

At Move 0-15 Position

2 Meaning of these output functions depends on context as follows:
For Absolute Move Types: Indicates when the actual position is within the window, defined 
by the In Position Window parameters, of the commanded Move.
For Move Type Unlimited (+) or (–)- Indicates the commanded and actual position are past 
the Position/Distance value of the move.

Comparator Outputs 
(Comparator 1 and 2)

Indicates when a Comparator output is active. Comparators were added in Tritex II AC 
90/115 mm at v2.21 firmware and Tritex II DC and AC 75 firmware at v2.37.

1

For Incremental Move Types: The At Move Position is NOT activated.

2 The standard Expert software does NOT allow this value to be changed “on screen”, however, this can be set using Modbus 
protocols. (See Tritex II Parameters manual for more information on additional parameters that can be accessed by Modbus 
commands)

There are a few other output functions that are not intended for general use not defined here 

12.4.2 Output Function Definitions

Enabled
Indicates the power stage of the drive is active. Requires that no faults are active, bus 
voltage is present and an Enable input function is active or Auto-enable on start-up is 
selected.

Homed

Indicates that a Home move has been completed or the Define Home input function had 
a rising edge so that absolute position is established. Homed goes inactive if a Home 
move is initiated, a Position Tracking Fault occurs or logic power is cycled. If the unit has 
the absolute feedback option, Homed will be set on power-up if the absolute feedback 
system has preserved absolute position.

Ready Indicates the drive is Enabled and Homed.

Faulted
Indicates the drive is in a fault condition. The active fault is displayed in the Status 
window. The user has control over some fault conditions. (See System Setup page).

Warning
Indicates a Warning condition. The active Warning is displayed in the Status window. The 
user may select which conditions indicate a warning. (See System Setup page section).

Fault or Warning This is the logical “OR” of the Faulted and Warning output functions.

Stop Indicates motion has been inhibited by an active Stop input function or fault action.

Pause Indicates motion is suspended by an active Pause input function.

Jog (+ / -) Indicates when Jog + or Jog - is active.

Default Mode Active Indicates when an actuator is in Default mode and Enabled.

Alternate Mode Active Indicates when an actuator is in Alternate mode and Enabled.

Homing Indicates when a Home move is active.

Dedicated Move Indicates when the Dedicated Move function is active.

Move Active
Indicates when any of the Moves (0-15) or Main Motion or Secondary Motion are active. 
This will also remain active if the Move Maintained input function is active, even if the 
specified Move is complete.

Secondary Active
Indicates when any of the Moves (0-15) Secondary Motion are active. This will also 
remain active if the Move Maintained input function is active, even if the specified Move 
is complete.

In Position
Indicates a target position has been reached within the window and for the necessary 
time defined by the In Position Window parameters.

At Home Position
Indicates when the actual position is within the window, defined by the In Position 
Window parameters, of the defined Final Home Position.

At Dedicated Position
Indicates when the actual position is within the window, defined by the In Position 
Window parameters, of the defined Dedicated Position.

At Home 2 Position
1 Indicates when the actual position is within the window, defined by the In Position 
Window parameters, of the defined Final Home 2 Position.

Shunt Active

Indicates when the shunt control circuit is active. It occurs when regeneration energy 
from deceleration or lowering a vertical load has raised the bus voltage above the shunt 
turn-on threshold. For the Tritex II DC actuators, it means that energy is being sent to a 
small internal shunt resistor. For Tritex II AC actuators, it means voltage is applied at the 
shunt resistor terminals.

Brake Release
Indicates when the brake is released, and the motor/actuator is free to move. This logic is 
active even if the unit has no brake and could be used to control an external brake.

1 The standard Expert software does NOT have an “on screen” parameter for setting a Final Home 2 Position, however, this can 
be set using Modbus protocols. (See Tritex II Parameters manual for more information on additional parameters that can be 
accessed by Modbus commands.)
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13. MANAGING APPLICATIONS
13.1 COPYING
When copying an existing set of user parameters to a different actuator to replace an actuator or create a new instance of a 
design, as long as the new actuator is the same drive type, it is possible to open the original application, connect, and download 
the user parameters. A normal download will not write factory parameters and a few other special parameters. Once written to 
the new actuator, the original application should be closed without uploading from the actuator. This is the best time to install the 
latest release of Expert software on the PC. Then create a new application for this actuator, connect, and upload parameters. 
The resulting new application folder will contain a complete record of the actuator parameters including factory parameters and 
parameters for new features for possible future use.

14. DIAGNOSTICS
14.1 DIAGNOSTICS PAGE
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Groups Description

Firmware Information Shows the Firmware and Boot version of the actuator

Actuator Information Shows the critical actuator information, such as position, temperature, and limits

H/W Output Status Actuator outputs with method to set output to a logic state

LED Output Status Shows current LED’s status and method to force on

Comms Channel Channel A and B communication status

Comms Errors Channel A and B Modbus communication fault information

Fault Status

Displays the currently active faults and their severity 

F – Firmware hard fault is active, which could cancel the move operation.

W – Firmware soft fault warning is active; the Warning will clear when the fault condi-
tion clears.

A – Fault and/or Warning is active
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14.2 STATUS LOG PAGE
The Status Log page can be found under the Diagnostics category of the page tree. Though not easily interpreted, it contains fault 
histories that are very useful in determining whether faults could be avoided by adjusting control parameters or if an actuator needs 
repairs. Unexplained faults should not be ignored, because some fault conditions can result in cumulative damage. Please contact 
our Tech Support group for help in determining underlying causes of faults.

Total power-up time and power-up count are displayed at the top. Power-up time is the time the actuator is enabled, not just the 
time all power is applied. If logic power is applied to keep the electronics running even when main bus power is off, a power-up is 
counted only after both main and logic power have been removed.

The Status Log page shows the number of fault occurrences and the power-up count and run time of the most recent occurrence 
for each fault condition in the Last Fault/Warning section. 

The Recent Fault History section displays the last ten faults that have been logged with #1 the most recent. The Power-up count 
and Time for each fault are also saved here. 

Maximum Stress Values indicate the maximum values for Current, Voltage and Board Temp seen by the drive since being shipped 
from the factory. On models equipped with an actuator temperature sensor rather than an overtemperature switch, the highest 
Actuator Temp will also be recorded here. Current Power-On Stress Values indicate the maximum current and voltage seen since 
the actuator was last restarted from a complete power down. These values can be reset for diagnostic purposes by clicking the 
Clear Run Time button. 

The power up time, count and stress values will only be stored to non-volatile memory every SIX minutes. Faults are saved to non-volatile 
memory immediately.

The data is uploaded for viewing but is not saved with the drive file.

14.2.1 Faults: Possible Causes and Solutions
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The next paragraphs describe the meaning of faults that may occur and be recorded in the Fault Log. There are a few that are not 
recorded in the fault log as well, also described here.

Peak Current

The Peak Current fault threshold is set at the factory and is above the Factory Current limit, meaning 
the actuator will never command enough current for a Peak Current fault. This fault can only occur 
under serious upset to the control loops operating in the actuator, possibly from a hard stop or 
severe supply voltage upset. The Oscilloscope function can be used to monitor the current to find 
upsets if there are nuisance Peak Current faults. They should not be ignored.

Continuous Current

The actuator continuously monitors motor current using an I2t calculation and compares the actual 
value to a factory limit. On reaching this limit, the actuator will limit current to not exceed the limit if 
the Foldback on continuous current box is checked on the Option tab of the System Setup page. 
Otherwise the actuator will fault and immediately disable. The Continuous Current fault is one of the 
most important protections against overload for the. Continuous Current can be monitored on the 
Monitor page.

Tracking Error

This is an internal fault that can only occur if the drive senses invalid position feedback signals. 
This condition cannot be resolved in the field; the unit must be sent to the factory for repair, with an 
important exception. For units with the absolute feedback option (-AF) running on older firmware, an 
Absolute Feedback Rollover fault was mapped into a Tracking Error fault and this condition is field 
re-settable. Contact Tech Support for advice on occasional faults that can be reset.

Low Bus Voltage

A Low Bus Voltage limit is set at the factory. Anytime the voltage goes below this preset value while 
the actuator is enabled, the drive immediately faults. A Low Bus Voltage condition is only considered 
a fault if the drive is enabled, that is, trying to operate when there is insufficient power to do anything. 
The Bus Voltage can be monitored on the Diagnostics page. 

High Bus Voltage

A High Bus Voltage limit is set at the factory, and on DC actuators a lower User High Bus fault 
may be set. Anytime the voltage goes above this preset value, the drive immediately faults. A High 
Bus Voltage fault can occur from overvoltage on the main power supply, but more likely from the 
bus voltage rising due to motor regeneration energy. For an AC powered actuator, the solution 
is generally to connect an external braking resister, though occasionally slower deceleration, or 
better position loop performance (less overshoot) is enough. For DC actuators regenerated energy 
handling can be more complicated and involve an RSR and blocking diodes to protect power 
supplies. (See the Installation Manuals for more details). The Bus Voltage can be monitored on the 
Diagnostics page, or with the Scope.

Following Error

This fault occurs if the Following Error (difference between target position and actual position) is 
beyond the Following Error limit and the Time in Following Error limit is exceeded. This will typically 
occur if the actuator cannot provide enough force/torque to get to the desired position, either 
because the active current limit is set too low or a there is a machine jam, hard stop, or end travel 
has been reached. Another cause could be attempting to accelerate a high inertia load too quickly. 
Following Error can and should be kept low by keeping requested motion within the limits of the 
actuator and properly tuning the actuator for its application.

Board Temperature

1 This condition occurs when a temperature sensor near the processor in the control electronics is 
over the factory set limit. This can occur if the actuator is continuously used above its power rating, 
or at high ambient temperatures.

Communications

This fault occurs if there is no activity on a communications channel for a configurable timeout 
interval. See the System Setup page Comms Faults tab for settings. This condition should be 
ignored – not even logged – unless continuous communications is required for operation, such as 
commands via Modbus or another fieldbus.

1

Power de-ratings apply to units operated at an elevated ambient.
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Actuator Temperature
1 This condition occurs when the temperature sensor in the stator winding reports a tem-
perature higher than the factory set limit.

Absolute Hall Battery

This condition should generally be set as a warning rather than a fault. It indicates that 
the battery that maintains multi-turn absolute position is running low. If it gets too low, 
position will not be retained, and a home sequence will have to be performed after a 
power-down.

Loss of Signal
This fault condition occurs only when the Enable High Trip or Enable Low Trip box is 
checked, and the Analog Input value drops out of range that is entered. See analog input 
page.

Hardware Current Trip

This fault indicates an abnormal current has been detected by high speed short-circuit 
detection electronics. It usually indicates an insulation breakdown, though can occur due 
to a severe transient voltage. If this fault recurs immediately on attempting to re-enable 
the actuator, do not keep trying to reset the fault. Secondary failures will eventually occur, 
causing supply fuses to open. This fault must not be ignored. Contact our tech support.

User Low Bus Voltage
A User Low Bus Voltage limit is set by the user; anytime the voltage goes below this 
value, the fault condition occurs. The Bus Voltage can be monitored on the Diagnostics 
page.

Absolute Feedback Rollover

With the absolute feedback (-AF) option the travel limit is 8192 motor revolutions, if the 
motor goes past 8192 revolutions the position will track properly until the next power 
cycle, at that time this fault will occur. The only recovery from this fault condition is to 
unplug the backup battery connector when all power (main bus and logic) is removed. 
Leave the connection off for about 1 minute then re-connect and power up. A home cycle 
will be required. This fault is only shown on firmware version 2.19 and higher for the 
Tritex 2 AC 90/115 mm or version 2.35 and higher for other drive types and with Expert 
Software version 4.5.2.6 and higher. In older firmware or software this fault condition is 
reported as a Tracking Error. The recovery is the same. Latest firmware and absolute 
feedback hardware eliminates the turns limit so this fault will not occur.

Move Termination

This condition can occur in any motion type with three different possible causes: (See the 
Move page).

If the Fault if not terminated by switch or current limit box is checked and the move is 
terminated by reaching the designated position without having activated a switch or 
reached the Current Limit value. 

If either Terminate on switch (active or inactive) is selected or Fault if terminated by 
switch is selected and the motion is terminated by the Switch Input rather than by Current 
Limit or reaching the designated position.

If the Terminate on current limit and the Fault if terminated by current limit boxes are 
checked and the Current Limit for the motion is hit before the Switch Input is sensed or 
before the designated position is reached.

Invalid Parameters or  
System Parameters

These faults involve parameter images in non-volatile memory. It is recommended that a 
drive file for each actuator is always saved, though having a drive file for each actuator is 
more likely to be used to install a spare actuator for other maintenance or repair purpos-
es. Contact the Tech Support group for recovery.

1 If the actuator has the hand wheel (–HW) or side drive (-SD) option, a switch to indicate manual operation is wired in series 
with the Actuator Temperature sensor to disable the actuator. Therefore, engaging the manual drive is recorded as an Actuator 
Temperature fault.
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14.3 SCOPE
The Tritex software has a Scope page that is a virtual oscilloscope that can plot up to four channels with either high speed or 
continuous data capture mode. It is vital for understanding the dynamics of servo motion control when optimum performance is 
required.

14.3.1 Button Controls

This button opens the Control Panel for configuration and precise 
setup. Details on this page are found later in this section.

This button stops data collection and plotting.

This button is for continuous capture/plotting where the Scope plots 
new data points as each channel variable changes value.

This button is for continuous re-trigger mode, where every time the 
trigger condition exists, the scope starts a new capture.

This button is a single capture where the scope will gather and plot 
one buffer full of data and then hold.

These four buttons toggle the capture and display of the four chan-
nels.

This button toggles the grid lines.

This button toggles the legend.

Actuator Temperature
1 This condition occurs when the temperature sensor in the stator winding reports a tem-
perature higher than the factory set limit.

Absolute Hall Battery

This condition should generally be set as a warning rather than a fault. It indicates that 
the battery that maintains multi-turn absolute position is running low. If it gets too low, 
position will not be retained, and a home sequence will have to be performed after a 
power-down.

Loss of Signal
This fault condition occurs only when the Enable High Trip or Enable Low Trip box is 
checked, and the Analog Input value drops out of range that is entered. See analog input 
page.

Hardware Current Trip

This fault indicates an abnormal current has been detected by high speed short-circuit 
detection electronics. It usually indicates an insulation breakdown, though can occur due 
to a severe transient voltage. If this fault recurs immediately on attempting to re-enable 
the actuator, do not keep trying to reset the fault. Secondary failures will eventually occur, 
causing supply fuses to open. This fault must not be ignored. Contact our tech support.

User Low Bus Voltage
A User Low Bus Voltage limit is set by the user; anytime the voltage goes below this 
value, the fault condition occurs. The Bus Voltage can be monitored on the Diagnostics 
page.

Absolute Feedback Rollover

With the absolute feedback (-AF) option the travel limit is 8192 motor revolutions, if the 
motor goes past 8192 revolutions the position will track properly until the next power 
cycle, at that time this fault will occur. The only recovery from this fault condition is to 
unplug the backup battery connector when all power (main bus and logic) is removed. 
Leave the connection off for about 1 minute then re-connect and power up. A home cycle 
will be required. This fault is only shown on firmware version 2.19 and higher for the 
Tritex 2 AC 90/115 mm or version 2.35 and higher for other drive types and with Expert 
Software version 4.5.2.6 and higher. In older firmware or software this fault condition is 
reported as a Tracking Error. The recovery is the same. Latest firmware and absolute 
feedback hardware eliminates the turns limit so this fault will not occur.

Move Termination

This condition can occur in any motion type with three different possible causes: (See the 
Move page).

If the Fault if not terminated by switch or current limit box is checked and the move is 
terminated by reaching the designated position without having activated a switch or 
reached the Current Limit value. 

If either Terminate on switch (active or inactive) is selected or Fault if terminated by 
switch is selected and the motion is terminated by the Switch Input rather than by Current 
Limit or reaching the designated position.

If the Terminate on current limit and the Fault if terminated by current limit boxes are 
checked and the Current Limit for the motion is hit before the Switch Input is sensed or 
before the designated position is reached.

Invalid Parameters or  
System Parameters

These faults involve parameter images in non-volatile memory. It is recommended that a 
drive file for each actuator is always saved, though having a drive file for each actuator is 
more likely to be used to install a spare actuator for other maintenance or repair purpos-
es. Contact the Tech Support group for recovery.

1 If the actuator has the hand wheel (–HW) or side drive (-SD) option, a switch to indicate manual operation is wired in series 
with the Actuator Temperature sensor to disable the actuator. Therefore, engaging the manual drive is recorded as an Actuator 
Temperature fault.
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These three buttons are helpful for zooming left or right on a plot 
segment. The pause button freezes the screen and enables the left 
and right buttons for scrolling through the entire buffer of data, half a 
screen at a time.

This button toggles between the default plotting method of data over 
time and the secondary method of plotting channel 1 over channel 2.

Save the data to a CSV file.

Recall data from a previously saved file.

Send the plot image to a printer.

The lower controls offer methods of tuning the display such as scaling, offset and time base.

This button, whose number changes as it is toggled, selects which channel will be affected when the Scale 
or Offset slide bars are used. This is also the channel that the values displayed on the vertical grid line will 
represent.

Auto Scaling
The displayed channel will be scaled vertically by percentage of the grid it takes up from its 
highest point to its lowest from 1% to 300%.

Scaling This selects the coarseness for the Scale slide bar

Scale
Moving this slide bar up or down changes the scale of the selected channel in the vertical di-
rection. For fine adjustments click on the slider arrow and use the keyboard up/down arrows.

Offset This applies a -50% to 50%

Timebase
This adjusts the scaling horizontally. It allows the user to select how much time passes 
from one vertical grid line to the next. Time increments from .001 seconds per line to 10.0 
seconds per line are available.

Upload When data buffer is full and is ready for Upload the Upload button text will turn green.

The bottom row displays the capture mode, time base and current value of each channel variable.
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14.3.2 Scope Controls

The Scope Control page is opened by using the Control Panel button .

Capture and Trigger Settings

Horz Timebase The horizontal time base of the Scope plot.

Auto Scaling
An automatic scaling vertically by percentage of the grid it takes up from its highest point to 
its lowest from 1% to 300%.

Capture Method

Constant Read takes in the channel and trigger data from conventional variable monitors 
and is not as precise as the high speed capture method due to delays from communications. 
High Speed Capture fills a data buffer on the drive and then uploads all data points at once 
when it is full. 

Trigger

This tells the scope to start capturing data to plot. The Trigger Variable and Trigger Variable 
Scale can be selected from the drop-down lists. Level is the value at which the trigger will 
occur and Rising/Falling Edge selection dictates if the capture is triggered as the value 
crosses the level from lower to higher or higher to lower.
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Channel Setup

Each of the four channels is set up on their own tab on this page.

CH# Display Name The name to be displayed by the Legend of the Scope.

CH# Vertical Scale The scaling of the vertical axis to be used if not using Auto Scaling.

CH# Vertical Offset The position vertically on the scope of the “zero” point of a set of data.

CH# Variable Select the variable for which this channel will capture data.

CH# Variable Scale Select the units appropriate for the data being captured.

Scope Appearance

The Appearance tab allows the user to select the colors and line widths for the background, grid, individual channels when plotted 
and displayed on the Scope.
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High Speed Capture

The High Speed tab lets the user set how much time passes between data points collected and how many data points will be 
displayed from before the trigger occurred. If insufficient time passes between enabling the scope to capture and when the trigger 
occurs, all the pre-trigger data may not be valid.
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15. FIELDBUS OPTIONS
15.1 ETHERNET/IP OPTION
15.1.1 Functionality

For detailed information on Tritex TTX & Tritex II EtherNet/IP & Rockwell AOI User Manual

The Tritex II EtherNet/IP option board supports the following features:

• Device IP Address assignment through BOOTP or through Tritex Expert software
• Drive commissioning through standard RS485 communication to Tritex Expert software
• EtherNet/IP device capable of Implicit I/O messaging
• Exlar supplied EDS file if required by client device
• Up to 100 input registers(INT16) and 100 output registers(INT16) are available to be user mapped to Tritex parameters 

through the Tritex Expert software
• Full functional control of Tritex parameters

15.1.2 Assignment of Tritex IP address

As with any Ethernet device, the Tritex contains a MAC-ID that is unique to this device. When assigning an IP address, this 
MAC-ID is useful for verifying device identity, so a printed label is applied to the actuator. Each device receives an IP address to 
identify itself to the Ethernet network. In addition, it also holds a default subnet mask and gateway for the network.

There are two ways of assigning the IP address to the Tritex:

• BOOTP Server

• Tritex Expert software

The default IP address settings loaded into the unit at the factory:

IP Address – 192.168.0.254 
Subnet – 255.255.255.0 
Gateway – 0.0.0.0

Setting the IP address is more conveniently accomplished through Tritex Expert software, so BOOTP must be disabled. This is 
done using a BOOTP server, if not already disabled.

For more information on IP addresses with BOOTP, refer to the EtherNet/IP Option Manual.

15.1.3 Tritex Expert Software IP Address Configuration

BOOTP must be disabled to set the IP address through the Tritex software.

When communications are online with the Tritex software, opening the EtherNet/IP page under the Networks category of the pages 
tree, you will see the TCP/IP parameters. The displayed values, under Current TCP/IP Properties-IP Address, Subnet Mask and 
Dflt Gateway-are the parameters set in the EtherNet/IP module. The fields under Edit TCP/IP Properties are for entering an IP 
Address, Subnet Mask and Dflt Gateway for using BOOTP or changing the default parameters. 

Be sure to select Save Addresses to Drive if modifying the TCP/IP properties. 

Changes to Ethernet parameters will not take effect until power to the drive is cycled. Upon power-up the new IP Address will be 
assigned and will show up in the current MAC-ID parameter container.
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15.1.4 EtherNet/IP Implicit I/O Messaging

Implicit I/O Messages are transmitted via UDP/IP. I/O Message connections are often established as One-to-Many relationships 
in the producer-consumer multicast model of EtherNet/IP. The data fields of I/O Messages contain no protocol information, only 
time critical I/O data. These messages are used to send and receive application-specific data over the network at regular intervals. 
The meaning of the data is pre-defined at the time the connection is established. I/O Messages contain Assemblies of several 
parameters that can be transmitted with a single message. 

The Tritex has a set number of 101 input and/or 101 output 16-bit registers that are transferred with each update. These registers 
are mapped to specific parameter definitions in the Tritex Expert software. Unmapped registers will carry data across with the 
messages but will not be associated to affect any functionality of the Tritex. Outputs are sent from the Tritex consistently while the 
Inputs only updates when a value is changed.

A Host is the device capable of initiating an EtherNet/IP Implicit connection with the Tritex, such as a PLC or other plant control 
system. The Assemblies used to setup the Host and transmit I/O Messaging data are:
Assembly 101 is defined for Host Inputs(Tritex Outputs) with a data size of 101 16-bit registers.
Assembly 102 is defined for Host Outputs(Tritex Inputs) with a data size of 101 16-bit registers.
Assembly 128 is defined for Configuration with a data size of 0 registers.

There are 100 usable input and output registers. Register 0 is reserved for the Tritex both on the Inputs and the Outputs. The Host must 
set register 0 to a value of 1 to enable writing data to the Tritex on the 100 registers.

15.1.5 Tritex Data Mapping to I/O Registers

All Tritex functionality is parameter based. This means there is a listing of parameters associated with every functional capability 
of the Tritex. When setting up the EtherNet/IP mapping to the 101 Inputs and 101 Outputs, first a list of the parameters must be 
defined and determined whether they are Read Parameters from the EtherNet/IP Host or Write Parameters to the EtherNet/IP 
Host. Once this list is created, mapping the parameters to the Translation Table of registers is done as shown in the Figure below. 
The Output Mapping tab is used to map the parameters that are output by the Tritex and read into the Host. The Input Mapping 
tab is used to map the parameters that are input to the Tritex and written from the Host. The Input Monitor and Output Monitor tabs 
work in the same manner.

Not all parameters in the list are compatible with all versions of firmware. If an EIP error occurs check the compatibility of the parameters 
in the table with the firmware version on the Tritex drive.

Selecting parameters to be mapped to the Translation Table. 
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After Step #2 in the Figure above, the information about the parameter is displayed. 32 bit or double word parameters can only be 
assigned to tables starting with odd numbers. If a 32-bit parameter is selected and even table number is selected the Add button 
will be gray. If, for example, only half of a 32 bit parameter is needed (all velocities are 32 bit parameters) their data format is 8.24 
revs/sec and rarely would 24 bits of precision be needed to the right of the decimal point), the user could select only the High word 
of the parameter, by un-checking the Low box, resulting in a 16 bit velocity parameter in the format of 8.8 revs/sec , 8 bits on each 
side of the decimal point.

Assigning the parameters to be transferred between the Tritex and PLC is simple; the hard part is understanding the Tritex 
parameters and their format so they can be controlled from the PLC. The Tritex II Parameters Manual describes the function of 
every parameter, in some cases even the interaction with other parameters, and most importantly the format of data for each 
parameter. Parameters such as Move distances and Velocity are straight forward, however, many of the parameters used for 
control are 16-bit registers represented by bit maps or Enumeration tables; the common bit maps are covered in Appendix A of the 
Tritex II Parameters Manual.

To assist with validating the data sent/received, the Input/Output Monitor tabs allow the user to view the non-scaled decimal value 
of the 16-bit register. This value will match the value observed from the Host. See Figure below to identify its use. 

 Monitoring parameters to validate data sent/received by the host. 
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15.2 PROFINET IO OPTION
15.2.1 Functionality

For detailed information on Tritex PROFINET IO setup see the Tritex II PROFINET IO Option Manual 

The Tritex II PROFINET IO option board supports the following features:

• Device IP Address assignment through DCP.

• Drive commissioning through standard RS485 communication to Tritex Expert software.

• PROFINET IO device capable of Implicit I/O messaging.

• Exlar supplied GSD file is required.

• Up to 100 input registers (INT16) and 100 output registers(INT16) are available to be user mapped to Tritex parameters through the Tritex Expert 
software.

• Full functional control of Tritex parameters.

15.2.2 Assignment of Tritex IP address

As with any Ethernet device, the Tritex has a MAC-ID that is unique to this device (located on the actuator label). PROFINET IO 
identifies nodes by the device name, but also assigns and uses IP addresses. When assigning an IP address and device name this 
MAC-ID is useful for identifying the device. Each device receives an IP address and device name to specifically identify itself to the 
PROFINET network. In addition, it also holds a default subnet mask and gateway for the network.

The IP address and device name to the Tritex is set through DCP (Discovery and Configuration) software.

The default IP address settings loaded into the unit at the factory:

Device Name – “” 
IP Address – 0.0.0.0 
Subnet – 255.255.255.0 
Gateway – 0.0.0.0 
IP Address assignment using DCP

A network scan run by the Engineering Tool for PROFINET IO setup software, such as Siemens Step 7 or NCM PC, detects and 
displays all PROFINET IO nodes that can be reached online along with MAC address, IP address, device name and device type. 
This application permits processing of the nodes, e.g. assigning the device name and changing the IP address.

15.2.3 Tritex Expert Software IP Address configuration

When communications are online with the Tritex software, opening the PROFINET IO page under the Networks category of the 
pages tree, you will see the TCP/IP parameters. The displayed values, under Current TCP/IP Properties-IP Address, Subnet Mask 
and Dflt Gateway-are the parameters set in the PROFINET IO module. These addresses are overwritten by the PROFINET setup 
tools (Step 7) or PLC, so they are not edited in the Tritex software.

15.2.4 PROFINET IO Messaging

I/O Messages are transmitted via UDP/IP. I/O Message connections are often established as One-to-Many relationships in the 
model of distributed PROFINET IO. The data fields of I/O Messages contain no protocol information, only time critical I/O data. 
These messages are used to send and receive application-specific data over the network at regular intervals. The meaning of the 
data is pre-defined at the time the connection is established. I/O Messages contain Assemblies of several parameters that can be 
transmitted with a single message. 
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The Tritex has a set number of 101 input and/or 101 output 16-bit registers that are transferred with each update. These registers 
are mapped to specific parameter definitions in the Tritex Expert software. Unmapped registers will carry data across with the 
messages but will not be associated to affect any functionality of the Tritex. Outputs are sent from the Tritex consistently while the 
Inputs only updates when a value is changed.

A Host is the device capable of initiating a PROFINET IO connection with the Tritex, such as a PLC or other plant control system. 

There are 100 usable input and output registers. Register 0 is reserved for the Tritex both on the Inputs and the Outputs. The Host must 
set register 0 to a value of 1 to enable writing data to the Tritex on the 100 registers.

15.2.5 Tritex data mapping to I/O registers

All Tritex functionality is parameter based. This means there is a listing of parameters associated with every functional capability 
of the Tritex. When setting up the PROFINET IO mapping to the 101 Inputs and 101 Outputs, first a list of the parameters must be 
defined and determined whether they are Read Parameters from the PROFINET IO Host or Write Parameters to the PROFINET IO 
Host. Once this list is created, mapping the parameters to the Translation Table of registers is done as shown in the Figure below. 
The Output Mapping tab is used to map the parameters that are output by the Tritex and read into the Host. The Input Mapping 
tab is used to map the parameters that are input to the Tritex and written from the Host. The Input Monitor and Output Monitor tabs 
work in the same manner.

Not all parameters in the list are compatible with all versions of firmware. If a PNIO error occurs check the compatibility of the parameters 
in the table with the firmware version on the Tritex drive.

Selecting parameters to be mapped to the Translation Table.

Tritex works with 16-bit words where PROFINET IO uses 8-bit bytes or “octets”. There will be two PROFINET IO octets for each Tritex 
word.

After Step #2 in the Figure above, the information about the parameter is displayed. 32 bit or double word parameters can only be 
assigned to tables starting with odd numbers. If a 32-bit parameter is selected and even table number is selected the Add button 
will be gray. If, for example, only half of a 32 bit parameter is needed (all velocities are 32 bit parameters their data format is 8.24 
revs/sec and rarely would 24 bits of precision be needed to the right of the decimal point), the user could select only the High word 
of the parameter, by un-checking the Low box, resulting in a 16 bit velocity parameter in the format of 8.8 revs/sec, 8 bits on each 
side of the decimal point.
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Assigning the parameters to be transferred between the Tritex and PLC is simple; the hard part is understanding the Tritex 
parameters and their format so they can be controlled from the PLC. The Tritex II Parameters Manual describes the function of 
every parameter, in some cases even the interaction with other parameters, and most importantly the format of data for each 
parameter. Parameters such as Move distances and Velocity are straight forward, however, many of the parameters used for 
control are 16-bit registers represented by bit maps or Enumeration tables; the common bit maps are covered in Appendix A of the 
Tritex II Parameters Manual.

To assist with validating the data sent/received, the Input/Output Monitor tabs allow the user to view the non-scaled decimal value 
of the 16-bit register. This value will match the value observed from the Host. See Figure below to identify its use. 

Monitoring parameters to validate data sent/received by the host.

Example 1: Writing Move 0 Position from the PLC to the Tritex
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1. Select the Input Mapping tab (Input to the Tritex from the PLC)
2. Select Move 0, Primary, Position
3. Click Apply: information about the parameter is displayed.
4. Since this is a 32-bit parameter, select an odd number in the Translation Table and Click the Add button.
5. After a download the Tritex is now ready to receive this data and write it directly to the Move 0 position register.
6. Click on the Help button and a PDF file will open explaining the Move parameter details. Move Position has a variable type 

of POS 32; the data table details the format is 16.16, (16 digits on each side of the decimal point), and the units are in Revs 
(motor revolutions).

Example 2: Enabling the Tritex from a PLC

1. Select the Input Mapping tab (Input to the Tritex from the PLC)
2. Enable bit is found in the Mode subgroup of Control/Input Functions. Click the Help button for details on the Input Function 

Events bit map. 
3. Select Control, Mode and Click Apply
4. Select the desired register number from the translation table. Since it is a 16-bit parameter either an odd or even number can 

be selected. 
5. From the information in found in the Help PDF, the bit map of the Mode word is shown as:

IEG_MODE
RESET BKOV TSEL TENA H2 H1 ALT EL EE
15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

As described bit “1”, EL is Enable Maintained

6. After a download, writing a “1” or “0” to bit “1” of word “3” from the PLC will control the Tritex Enable.
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The below figure shows the relationship between Tritex Input Translation Table to RSLogix Output controller tags

Tritex Expert Software RSLogix (I/O Connection)

Inputs Outputs
Tritex Input vs. RSLogix Output Tags
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15.3 MODBUS TCP OPTION
Modbus TCP works with the Expert software much the same as Modbus RTU, and once the Network Manager has been 
configured for the drive it should be transparent as to which protocol is being used.

It is necessary to connect Expert Software with an actuator over Modbus TCP to change the Ethernet parameters such as the IP 
address for the intended application. The following procedure shows how to establish a connection.

Select View → Network Communications Manager or click on the  button.

1) Click on the Add Network button. This screen currently shows a Modbus RTU connection present.

2) Select the Modbus TCP from the drop box.

3) Close the MODBUS TCP Network Properties window that opens.
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4) The Network Manager will now show both a Modbus RTU and the new Modbus TCP connection.

5) Scan for Drive

a) Change Status of ModbusTCP network to Connected and any other networks to Disconnected by clicking on the box and 
 the  for a pulldown menu and then selecting from the menu

b) Select the ModbusTCP Network
c) Scan network

Above image shows ModbusRTU and ModbusTCP networks installed; and ModbusTCP enabled.

2) Click here to select (highlight) 
the ModbusTCP network

1) Change Status 3) Select Scan Network 
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15.3.1 No Ethernet Network is Found

If no Ethernet Network is found, continue with these steps

Above image is after ‘Scan Network’ and Ethernet Network interface not detected. This is not a likely result, but needs to be fixed 
in the PC first. More likely there will be one or more IP addresses. However if nothing shows up in the Connections area as shown 
above, there is a problem with the Ethernet link between PC and actuator. Make sure network status LED’s are green and the PC 
Network Interface Status is OK. Make corrections as needed and scan again.

15.3.2 Use a different subnet

The above images show a device was found but it was on a different subnet, so could not connect. Check that the MAC ID is the 
actuator to be connected. Change PC Ethernet network properties to match found actuator subnet, meaning the first three numbers 
match. Then press Scan Connection button again.

If more than, one TCP drive is found, select the drive that matches MAC ID by highlighting drive in ‘Connections’. This will become 
the active drive. If all that was desired was to find the IP address, the task is done. If the IP address needs to be changed see the 
Change IP Address section.
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15.3.3 Change IP Address

Select Drive → Read Parameters from Drive or click on the  button.

If more than one connection is available, a Connection page appears and user must select the connection for the drive, which is 
the ModbusTCP connection in this case. (This would happen only if an RS-485 connection is also available.)

If the IP address is to be changed to connect into the end use network, open the ModbusTCP page from the Networks group. Type 
in the new IP address and other parameters as needed and click on the Save Addresses to Drive button.

The values on this page are NEVER read from the actuator. The only place the actual IP address is displayed is on the Network Manager 
window.
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After saving to drive, the connection will be lost immediately. Many times there is no further reason to connect to the drive via the 
ModbusTCP network from Expert Software. The connection can be accessed over the ModbusRTU network. Reconnection is 
possible over ModbusTCP, but the Network Interface may have to be changed to the new subnet, and the network will need to be 
scanned again.

It is a good idea to enter the actual IP Address and Subnet Mask on the ModbusTCP page and save the drive file for this actuator, 
just as a place to put them.

Expert Software must be connected to the actuator using Modbus/TCP to change IP Properties.

15.3.4 Tritex Data Mapping to I/O Modbus Registers

This works with the same data mapping tables that are used for EtherNet/IP. The differences are that it is a “0” based table instead 
of “1” based table and the numbers displayed in the table are the Modbus addresses, rather than EtherNet/IP addresses. When 
used with Modbus, these tables can be used to group together into one location parameters that are used frequently. These 
parameters can then be written to or read in one block through Modbus RTU or Modbus TCP.

(See the Tritex Data Mapping to I/O Registers in EtherNet/IP Options section for detailed instructions on how to setup 
and edit these tables.)
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16. VALVE CONFIGURATION
16.1 STARTING A NEW VALVE APPLICATION 
Select File → New → Application or click on the  button.

Select the appropriate drive and then select Linear Valve Control from the Application Templates.
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16.2 VALVE DIGITAL I/O

Click on the Edit button to show the Input / Output selection screens.

Select the Input/Output from the drop box.

Select the desired function from the Functions tree. A description of the function will appear for the action that will be taken. Click 
the Apply button to assign the function to the selected Input/Output.

A few additional items that are available specifically for valves are:

Calibrate Stroke An input event which will initiate the stroke calibration.

User Configuration Reset An input event which will clear the stroke calibration completed flag. 

At Closed Position An output event which will be active when the actuator is at the closed position.

At Open Position An output event which will be active when the actuator is at the Open position.
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16.3 VALVE APP HOME

Direction Select plus or minus direction; minus is the default.

Velocity
This is the Home move maximum velocity. This may or may not be achieved, depending on 
the distance traveled and acceleration parameter.

Acceleration The acceleration ramp used during a Home move.

Current Limit

1 This sets the current limit for the Home move when the box is checked. If the Terminate on 
Current Limit box is checked, the Home move will terminate when the motor current is equal 
to or greater than this value. (The time to satisfy a Terminate on Current Limit condition is 
determined by In Current Limit Time parameter on the System Setup page). If the Terminate 
on Switch Active box is checked and the Current Limit box is checked, and the value is 
exceeded before a switch is found, a Switch is Not Found Fault will occur. (See Faults & 
Warning)

Terminate on Current Limit/
Switch Active

This action will end the searching portion of the Home move. A specified current limit AND/
OR switch (1-16) input function, can be used to terminate the Home move.

Home Offset
The Home Offset is a distance moved after a termination condition is satisfied. Typically it 
is used to move from a hard-stop when Terminate on Current Limit is used. If no offset is 
desired, enter “0”.

Offset Velocity The velocity used during the offset portion of the move.

Final Home Position
The commanded and actual positions are set to this position at the completion of a Home 
move.

Auto Home on Enable If this box is checked, a Home move will automatically be performed on enable.

Require Home before Default/
Alternate Mode operation

If checked requires a Home to be completed before operation from the Default/Alternate 
mode operation.

Link Home Velocity and Cur-
rent Limit to the Calibrate Move

2 If checked the Velocity and Current Limit for the Stroke Calibration will be set to the same 
values as the home move.

Enable Digital Mode If pressed selects alternate (digital) control mode to allow home and jog functions.

Home If pressed initiates home motion.

1 If the Current Limit box is checked, and the Terminate on Switch Active box is checked, do NOT select both Auto Home on 
Enable and Auto Enable on Start-up (System Setup page). If the actuator is against a stop in the home direction, each time the 
fault is attempted to be cleared another home against the stop is executed creating another fault.

2
This feature is available in Firmware version 2.37 and higher for the DC and 75 mm AC Tritex and version 2.20 or higher for 
the 90/115 mm AC Trite.
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16.4 VALVE STROKE

Actuator Direction

1 Retract to Close/Extend to Close changes the polarity of movement for all commands and 
feedback (position, velocity and current). This is used to change the actuator direction with-
out changing the commanded positions, velocities or torques.

Close Valve/Open Valve
2 Enter the mA position you need for the closed and open positions. This can be either 4 mA 
or 20 mA, depending on your control loop configuration.

Velocity/Acceleration Set the Velocity and Acceleration Limits for the valve stroke.

1
Changing this flag changes the definition of all absolute position and therefore automatically clears the Homed output function. 
A Home is required to resume operation.

2

There are three methods of determining the stroke or span of the valve: The desired positions corresponding to 4 mA and 20 
mA can be entered directly. The positions can be manually taught using jog mode or the can be automatically learned using the 
automatic stroke calibration function.

To change the command signal to voltage, go to the System Setup section of this manual.

The final valve stroke length is the difference between the open valve position and the closed valve position. The open valve 
position must be greater that the closed valve position. If you are unsure of the valve stroke, you can also set these parameters 
by using the jog mode.
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16.4.1 Manual Teach Controls

Selecting Digital Jog Mode allows the valve to be manually jogged to its closed and open positions. Click on the 
Digital Jog Mode button to enable this feature.

The analog signal will be disabled while in digital mode.

To close the valve, select the Jog to Closed Position button and hold it down with your mouse until the desired 
position is reached. You may then select Teach Closed Position to automatically fill in the closed valve position 
parameter. To open the valve, hold down the Jog to Open Position button until you have reached the desired position. 
Select the Teach Open Position to automatically fill in the open valve position parameter.

Unselect Digital Jog Mode to re-enable the analog signal.

16.4.2 Automatic Stroke Calibration

This feature is available in Firmware version 2.37 and higher for the DC and 75 mm AC Tritex and version 
2.20 or higher for the 90/115 mm AC Trite.

Automatic Stroke Calibration

Calibrates the stroke by moving to the in the retract direction until the current limit 
is reached and then doing the same in the extend direction. This function can 
occur either by pressing the Calibrate Stroke button shown above or by setting an 
Input Assignment to Calibrate Stroke and activating the assigned input.

Calibrate Stroke
Calibrates the span by finding the minimum and maximum positions. The LED’s 
will display the status by turning on when the Close and Open positions have been 
set. Once Calibration has been set, it will survive a power down / power up cycle.

Reset Calibration Clears the calibration complete flag.

16.4 VALVE STROKE

Actuator Direction

1 Retract to Close/Extend to Close changes the polarity of movement for all commands and 
feedback (position, velocity and current). This is used to change the actuator direction with-
out changing the commanded positions, velocities or torques.

Close Valve/Open Valve
2 Enter the mA position you need for the closed and open positions. This can be either 4 mA 
or 20 mA, depending on your control loop configuration.

Velocity/Acceleration Set the Velocity and Acceleration Limits for the valve stroke.

1
Changing this flag changes the definition of all absolute position and therefore automatically clears the Homed output function. 
A Home is required to resume operation.

2

There are three methods of determining the stroke or span of the valve: The desired positions corresponding to 4 mA and 20 
mA can be entered directly. The positions can be manually taught using jog mode or the can be automatically learned using the 
automatic stroke calibration function.

To change the command signal to voltage, go to the System Setup section of this manual.

The final valve stroke length is the difference between the open valve position and the closed valve position. The open valve 
position must be greater that the closed valve position. If you are unsure of the valve stroke, you can also set these parameters 
by using the jog mode.
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16.5 CUSTOMIZE STROKE CALIBRATION

Customize Calibration allows the user to customize the complete calibration process. Except for the select boxes on the bottom, 
the page is just like the Move Setup page used in the Generic Application and described earlier in this document except instead of 
Move 0 – Move 15, the moves are Calibrate Open and Calibrate Close. Note that Calibrate Close is the move that is initiated when 
the Calibrate Stroke button is pushed. The Calibrate Open move occurs because the Auto-Start Next Move check box is set and 
the selection is set to Calibrate Open.

Below the move setup information are check boxes allowing specific events to occur at the completion of the select move 
(Calibrate Open or Calibrate Close). 

Set Valve Closed Position Sets the valve close position to the current position.

Set Valve Open Position Sets the valve open position to the current position.

Set Stroke Calibration Complete Sets the Calibration Complete event.

Set Position as Home Reference Makes the completion of the move cause a redefinition of the home position.

Set Analog Output Minimum
Sets the Var Min on the Analog I/O page. This setting assumes that Output Variable is set to 
either FeedbackPosition or CommandPosition.

Set Analog Output Maximum
Sets the Var Max on the Analog I/O page. This setting assumes that Output Variable is set to 
either FeedbackPosition or CommandPosition.

Set Position of Closed Output Sets the position at which the At Closed Position output function will turn on.

Set Position of Open Output Sets the position at which the At Open Position output function will turn on.

Stroke calibration process will use the Home velocity and current limit. If it is not set, it will be up to the user to set those values for 
the open and close moves found on the Stroke Cal. Setup page described above.

Commissioning Software Tool
TRITEX® SERIESactuators



Expert™ Software Manual for Tritex® Actuators | 97www.exlar.com | 952.500.6200

16.5 VALVE SEATING

Travel Cut-off Position

1 The Tritex software has a valve seat algorithm that allows the actuator to switch from 
position mode to torque mode at a pre-determined position based on the milliamp signal; 
selecting the respective check box with enable this feature. The control is switched to 
torque mode when the Position Command exceeds the set closed or open travel cutoff. 
This causes the actuator to apply a force without concern for actual position. The user can 
determine how fast and how much force should be applied to properly seat the valve without 
damage.

Seating Velocity
The maximum velocity for the seating move, after reaching the cutoff position has been 
reached.

Peak Seating Current
This determines the force that the actuator will use to seat a valve in position. Peak Seating 
Current should be set to provide the desired level of force to fully close (or open) the valve.

Foldback Seating Current

2 This determines the force that the actuator will use to hold a valve in position once seated. 
When calculating the Foldback Seating Current, use the following equation to calculate the 
force applied:
Seating force (lbf) ~= Foldback Seating Current (Amps) x Kt (lb-in/Amp) x 5.34 / Screw Lead
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